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Change log
Note  

Document announcement. This 2021.2 version of the document will be the last one available as a 
PDF. All content is found in the online help and will only be maintained there going forward. From the 
portal or the Schedule Grid, click Help to view the topics for the Schedule screen.

2021.1 and 2021.2 - updated November 2021

Topic Description

Various 
topics

Updated the information about interacting with the Schedule screen to include clicking 
and dragging as a way to select multiple cells.

2021.2 - released November 2021

Topic Description

Scroll Bars (on page 79) Added information for the new scroll map functionality.

2021.1 - released June 2021

Topic Description

Topics under Edit 
Menu Options (on 
page 23)

Topics under 
Schedule Grid 
Functions (on 
page 80)

Updated several topics for the new functionality that allows for selecting 
multiple cells so that you can use the scheduling options across multiple 
days or employees.

Show/Hide Details (on 
page 67)

This section was updated with new instructions for the updated look and 
functionality of the Schedule screen.
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Schedule Screen Overview
The purpose of this information is to give you an explanation of the different parts of Staffing and 
Scheduling's Schedule screen and the functions available to you.

Performance consideration

The Schedule screen can support the following usage scenarios with minimal performance issues:

 l A six-week schedule period with 3,000 employees (each with one schedule per day)

 l A four-week schedule period with 4,500 employees (each with one schedule per day)

Note that these scenarios are approximations. The number of supported employees can change with 
different length schedule periods and having more or fewer transactions per day.

Overview

The Schedule screen is used to view, add, edit, and delete employee schedules and to view the staffing 
coverage for the selected organization units and date range. It is a powerful scheduling tool and while this 
guide gives you a good overview of it, you should contact symplr Customer Support if you have any 
questions or complex scheduling situations.

The structure of the Schedule screen is labeled and explained in the following image and table.
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The schedule screen is divided into the following areas:

Letter 
on 
image Area Description

A Toolbar The toolbar displays menu options for various functions. Click a menu 
option, such as Schedule or Edit, to view the related functions.

B Schedule 
period 
navigator

The navigator displays the date range of the schedule you are viewing. 
Click the left or right arrow to move to the previous or next schedule 
period.

C Schedule 
filter

The filter allows you to display only the information you are interested in or 
to limit the visible data. For example, you can add a filter that allows you to 
only see RNs working the Evening coverage period.

D Employee 
information

The employee information area displays the names of the employees in 
the open schedule. Other employee details are available, such as phone 
number, seniority date, approved hours, and scheduled hours. In addition, 
when you rest on a name, details are available in a tooltip and can display 
different details than what you see on the screen.

E Schedule 
grid

The schedule grid area displays the employees' schedules and allows 
you to view, add, edit, and delete schedules. When you rest on a 
schedule, a tooltip displays the profile, activity code, start and end times, 
and organization unit for the schedule.

F Schedule 
period 
information

This area contains tabs used to view specific information about the 
schedule you are viewing.

For example, the Balancing Grid displays the staffing coverage and need. 
The values in these cells can show you the need, the coverage, the 
variance (as shown in the previous illustration), or a coverage/need 
fraction. When you rest on a cell, a tooltip displays the coverage, need, 
and variance.

Tip  

Click on a cell and the employee schedules that are providing 
coverage for that profile/date are highlighted in the schedule grid.

Other tabs include: Requests, Employee Schedule Exceptions, Activity 
Balancing Grid, and View Calculated Data.
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Letter 
on 
image Area Description

G Information 
bar

The information bar displays, on the left side, the status of any processing 
happening for the Schedule screen, such as Synchronizing schedule and 
Synchronizing employee exceptions. These messages only appear as the 
system is completing a process; normally, this area is blank. On the right 
side of the information bar, a zoom slider allows you to zoom in and out to 
make viewing the screen more manageable for you.

Related information

Opening a Schedule (on the next page)

Tool Bar Functions (on page 12)

Scheduling Period Navigator (on page 65)

Employee Information (on page 66)

Schedule Grid (on page 72)

Zoom Control (on page 92)

Balancing Grid and Activity Balancing Grid (on page 93)

Requests (on page 110)

Employee Schedule Exceptions (on page 121)
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Opening a Schedule
The Open Schedule dialog box is used to enter criteria to open the Schedule screen for a certain time 
period and for a single organization unit or schedule group. An archived schedule can also be opened 
from the Open Schedule dialog box.

Open the Schedule screen

To open the Schedule screen, complete the following steps.

 1.  Navigate to Actions > Scheduling > Schedule.

After a few moments, the Schedule screen window appears with the Open Schedule dialog box.

If you are already viewing the Schedule screen, click Schedule > Open.

 2.  In the Open Schedule area, select the appropriate option.

 l Organization Unit opens the schedule for a single organization unit. The trunk level, such as 
facility, and branch level, such as department, organization unit levels are required. The leaf 
level, such as unit, level is optional.

 l Schedule Group/Profile Group opens the schedule for a Schedule Group, which contains 
multiple organization units set up together, as well as Profile Groups.

Note  

Schedule Groups must be previously set up here: Configuration > Scheduling > Schedule 
Group.

The Profile Groups that are available must be previously added here: Configuration > Labor 
Distribution > Profile Group, and then assigned here: Configuration > Labor Distribution > 
Profile.

Note  

If preferences have been set up, you may see a default organization unit or schedule group 
already entered in the fields. Even if a default organization unit or schedule group appears, you 
can override the prefilled information with the desired organization unit or schedule group.

To set up default preferences, navigate to Preferences > My Preferences (or System 
Preferences) > Default Organization Unit (or Default Schedule Group).

 3.  In the Select Date area, select the appropriate option.

 l Schedule Period is used to select a predefined scheduling period for the organization unit or 
scheduling group. This value defaults to the schedule period that contains the current date. 
From the drop-down menu, select the desired schedule period.

 l Custom Date is used to define the time frame to open. Enter the Start Date and End Date, or 
select the dates from the drop-down menus.

 4.  When all options are filled in, click Open Schedule.
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Open an archived schedule

A schedule that was previously archived can be opened and viewed by using the Open Archive tab.

For more information on archiving schedules, see Archive (on page 22).

To open an archived schedule, complete the following steps.

 1.  Navigate to Actions > Scheduling > Schedule.

After a few moments, the Schedule screen window appears with the Open Schedule dialog box.

If you are already viewing the Schedule screen, click Schedule > Open.

 2.  Click the Open Archive tab.

 3.  Select the Organization Unit or Schedule Group option.

 4.  Enter (or search for and select) the desired organization unit or schedule group.

 5.  Optional. In the Description field, enter the description of the previously archived schedule.

 6.  Optional. In the Contains Date field, enter a date (or select a date) that fell within the schedule period 
of the archived schedule.

 7.  Click Search.

Schedule archives that match your selected criteria appear in the Search Results area.

 8.  Select the desired archived schedule and click Open Schedule.

The archived schedule appears in read-only mode.
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Tool Bar Functions
The Tool Bar displays menus of functions, or icons for launching actions.

Click on the option in the tool bar to open the related menu. Then click on the menu item to launch the 
function.

Note  

If keyboard keys can launch the same function, they are also displayed.

The following tool bar options are available:

Schedule 
Menu 
Options  (on 
the next 
page)

Opens a menu of options for the schedule screen.

Edit Menu 
Options (on 
page 23)

Opens a menu of options for editing the cells of the schedule grid.

View Menu 
Options (on 
page 31)

Opens a menu of options for viewing or highlighting the schedule.

Tasks Menu 
Options (on 
page 38)

Opens a menu of options to launch a related screen in the portal to complete a task or 
action.

Help Menu 
Options (on 
page 63)

Opens the help options, which includes the About screen with copyright and 
trademark information about the schedule screen.

Click on this icon to refresh the information in the schedule. This will load information 
that has been entered and saved by other users and also changes made in the portal, 
such as updates to employee information or added or edited activity codes.

Schedule Menu Options 
The Schedule menu option opens a listing of functions for the entire schedule screen. Click on the option 
in the menu to launch the function or to open a set up screen.
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Open
The Open function opens a screen to enter criteria when opening a different schedule. This can be for a 
different for a single organization unit or for a schedule group and/or for a different date range than the 
open schedule.  

An archived schedule can be opened by accessing the Open Archive tab and completing the screen 
displayed.

Note  

For more information, see .

To open a schedule, complete the following steps:

 1.  In the tool bar, Schedule menu, select the Open function.

The following screen is displayed.
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 2.  In the Open Schedule area, select the appropriate option button to enable the corresponding 
selection fields.

 l Select the Organization Unit button to open the schedule for a single organization unit. The 
trunk level, such as facility, and branch level, such as department, organization unit levels are 
required. The leaf level, such as unit, level is optional.

 l Select the Schedule Group/Profile Groups button to open the schedule for a Schedule 
Group, which contains multiple organization units set up together, as well as Profile Groups.
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Note  

Schedule Groups must be previously set up on the Schedule Group screen. The Profile 
Groups that are available must be previously added on the Profile Group screen, and then 
assigned on the Profile screen.

 3.  If defaults are set up for the organization unit or schedule group, these fields are automatically filled. 
However, a different organization unit or schedule group can be entered. Click on the search icon to 
the right of the field to access the options for the field.

Note  

For more information on setting up a default organization unit, see Preferences > Default 
Organization Unit. For more information on setting up a default scheduling group, see 
Preferences > Default Scheduling.

 4.  In the Select Date area, select the appropriate option button to activate the corresponding date 
fields.

 l Select the Schedule Period option to select a predefined scheduling period for the 
organization unit or scheduling group. This value defaults to the schedule period that contains 
the current date. Click the drop-down menu icon to the right of the field to view a listing of the 
schedule periods.

 l Select the Custom Date option to define the time frame to open. Enter the Start Date to 
indicate the first day of the date range to open and the End Date to define the last day of the 
date range. Click the drop-down menu icon to open a calendar to select the dates.

 5.  When all options are filled in, click on the Open Schedule button.

Note  

To stop the process of opening the schedule, click on the Cancel button. The set up screen will 
close.

Reports
You can view the following reports directly from the Schedule screen.

 l 2 Week Schedule – This report shows the current schedule for a two-week date range.

 l 4 Week Schedule (Legal) – This report shows the current schedule for a four-week date range, 
displayed on legal sized paper.

 l 4 Week Schedule (Letter) – This report shows the current schedule for a four-week date range, 
displayed on letter sized paper.

Staffing and Scheduling Schedule Screen User Guide

© 2021 symplr. All rights reserved. Page 15 of 121



To access these reports, complete the following steps.

 1.  Click Schedule > select the report to view.

 2.  In the Report Preferences dialog box, select the Balancing Grid or Activity Balancing Grid 
option, and click Show Report.

Create Schedule
The Create Schedule function opens a wizard used to run the scheduling process for the open 
organization unit or schedule group.

To create a schedule, complete the following steps:

 1.  From the tool bar, click Schedule > Create Schedule.

The Create Schedule Wizard appears.

 2.  Some fields are filled in for you. Update any prefilled fields and enter the necessary information in 
the remaining fields.

 l Start Date and End Date

The dates for the open schedule period appear but can be changed; however, both dates must 
fall within the open schedule period.

 l Selection Style

The default Selection Style appears, but a different one can be selected.

 l Create Schedule Audit Report
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This option, when set to Yes, generates a report that tracks whether employees were 
scheduled and any reasons that disqualified them from being scheduled. This report is viewed 
in Reports > Scheduling > Create Schedule Audit Report.

 l By Profile

This option determines whether to run the scheduling process for all profiles or only for 
selected profiles.

 o No - the scheduling process is run for all profiles in the selected organization unit or 
schedule group

 o Yes (then click Next) - the next step of the wizard allows you to search for and select the 
profiles to include in the scheduling process

 l Employee Class Code

This option allows you run the scheduling process for a specified employee class. Click the 
search icon to search for and select an Employee Class Code or leave blank to run the process 
for all employee classes.

 3.  Click Finish.

When the process finishes, the schedule screen is updated with the results of the scheduling 
process.

Tip  

To view any error messages, open the report in Actions > System > Process Reports > 
Process Definition Code field = Schedule.

Create Employee Schedule
The Create Employee Schedule function opens a wizard used to run the scheduling process for a single 
employee.

To create an employee schedule, complete the following steps:

 1.  Click the name of the employee whose schedule you are creating.

The employee row is highlighted.
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 2.  From the tool bar, click Schedule > Create Employee Schedule.

The Create Employee Schedule wizard appears.

 3.  Some fields are filled in for you. Update any prefilled fields and enter the necessary information in 
the remaining fields.

 l Start Date and End Date

The dates for the open schedule period appear but can be changed; however, both dates must 
fall within the open schedule period.

 l Selection Style

The default Selection Style appears, but a different one can be selected.

 l Create Schedule Audit Report

This option, when set to Yes, generates a report that tracks whether the employee was 
scheduled and any reasons that disqualified the employee from being scheduled. This report is 
viewed in the Reports > Scheduling > Create Schedule Audit Report.

 4.  Click Finish.

When the process finishes, the schedule screen is updated with the results of the scheduling 
process.

Clear
The Clear schedule function opens a wizard used to clear employee schedules for the indicated time 
frame. Schedules can be cleared for the entire open schedule period or for a shorter time frame within the 
open schedule period.
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To clear the activities from the schedule, complete the following steps:

 1.  From the tool bar, click Schedule > Clear.

The Clear Schedule Wizard appears.

 2.  If needed, select a Start Date and End Date for the time frame to clear the schedule.

The start and end dates of the open schedule period appear by default but can be changed; 
however, both dates must fall within the open schedule period.

 3.  In the Employee Selection menu, select the option for the employees whose schedules will be 
cleared.

 l Current Employee - the employee highlighted on the schedule grid

 l Select Employees - choose employees from a list

 4.  Click Next and complete the steps from one of the following subheadings, depending on whether 
you selected Current Employee or Select Employees.

Current Employee

The employee's schedules appear, with individual rows for the different combinations of Location, Type, 
and Source.
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 1.  Select the boxes for the rows of the schedules you need to clear.

 2.  Click Next.

 3.  To make changes to which schedules will be cleared, click Back and repeat steps 1 and 2.

 4.  When you are ready to clear the schedules, click Finish.

The schedules are removed from the schedule.

Select Employees

The employees from the schedule grid appear.

 1.  Select the boxes for the names whose schedules you need to clear.

 2.  Click Next.

 3.  Select the boxes for the rows of the schedules you need to clear.

 4.  Click Next.

 5.  To make changes to which schedules will be cleared, click Back and repeat steps 1 - 4.

 6.  When you are ready to clear the schedules, click Finish.

The schedules are removed from the schedule.

Publish Schedule
The Publish Schedule function opens a screen to publish all or part of the open schedule. The user can 
publish all schedules or just the schedules visible when a filter is applied. The user can also select 
whether to publish schedules that employees have in other organization units, or only those schedules in 
the currently open organization unit.

To publish a schedule, complete the following steps:

 1.  From the tool bar, select the Schedule option, then the Publish Schedule command.

The following set up screen is displayed.
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 2.  In the Schedules field, indicate whether to publish all the schedules in the open schedule, or only 
those schedules that are visible. If a schedule filter is loaded and the Visible option is chosen, only 
those schedules included in the filter are published.

 l If the All Schedules option is chosen, all the employee schedules in the open schedule screen 
are published.

 l If the All Visible Schedules option is chosen, only the employee schedules that are currently 
visible in the schedule screen are published. For example, if there is a filter loaded to view only 
RN's positions on the Day shift, when the All Visible Schedules options is selected, only 
activities that are scheduled for RN positions and that overlap the Day coverage period are 
published. 

Note  

For more information about applying a schedule filter, see Schedule Filters (on page 74).

 3.  In the Distribution field, indicate whether to publish only the employee schedules that apply to the 
currently opened organization unit/schedule group, or whether to also publish schedules in alternate 
labor distributions for any employee on this schedule screen.

 4.  Enter the Start Date and End Date of the date range to publish the schedule. The start and end 
dates of the open schedule are defaulted but can be changed, as long as the dates fall within the 
open scheduling period.

 5.  The Organization Unit or Schedule Group values are defaulted from the open schedule screen and 
cannot be updated.

 6.  Click on the Publish button to publish the schedules. 
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Note  

Published schedules are displayed in the schedule grid with the text and schedule box border in 
bold.

Pending Schedule Published Schedule

Archive
The Archive Schedule function opens a screen to create an archive of the open schedule. An archive is a 
snapshot of a schedule showing the employee assignments and staffing requirements on a particular 
date and time. No edits can be made to an archived schedule.

Multiple archives can be taken of the same scheduling period. For example, an archive can be taken 
when the schedule is finalized before the first day of the scheduling period, and another one can be taken 
after the scheduling period is over.

To archive a schedule, complete the following steps:

 1.  From the tool bar, select the Schedule menu, then the Archive Schedule function.

The following screen is displayed.

 2.  In the Description field, enter a label for this version of the archived schedule.

 3.  Click on the Create Archive button to create the archive.

 4.  Archived schedules can be opened and viewed, but cannot be modified in any way.

Note  

For more information about searching for and viewing an archived schedule, see Open an 
archived schedule (on page 11).
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Edit Menu Options
The options in the Edit menu are used to modify the employee schedules in the Schedule Grid. Highlight 
a schedule (a calendar or clocking), a cell, or multiple cells, and then click on the appropriate Edit option. 
The options that are enabled (displayed in bold) are available for a cell. 

Many of these options can also be accessed by right-clicking when the cursor is in the employee 
schedule grid.

Cut
The Cut and Paste options allow you to remove a schedule from one or more cells and then paste it in 
another cell for the same or different employee. You can continue to paste this same schedule into as 
many cells as needed.

Note  

If you paste into a cell that already has a schedule, the behavior of the original schedule is determined 
by indicator SS Application: SS Solution Standard 5, "Determines the copy and paste method used by 
the Schedule screen".

If the indicator is set to:

 l A - the new schedule is appended, leaving the original schedule in place.

 l O - the new schedule overwrites (deletes) the original schedule.

To cut and paste employee schedules, complete the following steps:

 1.  In the schedule grid, highlight the cell or cells with the schedules to be cut (removed).

If a cell has more than one schedule and you want to cut only one of them, click the schedule itself to 
highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Use one of following methods to cut schedules:

 l Right-click to display the menu and select Cut. OR

 l From the tool bar, select the Edit menu, then the Cut option. OR

 l On the keyboard, press Ctrl-X.

 3.  Highlight the cell where the schedules should be pasted.
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 4.  Use one of following methods to paste schedules:

 l Right-click to display the menu and select Paste. OR

 l From the tool bar, select the Edit menu, then the Paste option. OR

 l On the keyboard, press Ctrl-V.

The schedule you cut is now assigned to the highlighted cells.

Copy
The Copy and Paste options allow you to make a duplicate of one or more employee schedules and then 
to paste in another cell for the same or different employee. The copied schedules will have the same 
assignment information as the original, such as activity code or profile. You can paste this same schedule 
into as many cells as needed.

Note  

If you paste into a cell that already has a schedule, the behavior of the original schedule is determined 
by indicator SS Application: SS Solution Standard 5, "Determines the copy and paste method used by 
the Schedule screen".

If the indicator is set to:

 l A - the new schedule is appended, leaving the original schedule in place.

 l O - the new schedule overwrites (deletes) the original schedule.

To copy and paste employee schedules, complete the following steps:

 1.  In the schedule grid, click the cell or cells with the schedules to be copied.

If a cell has more than one schedule and you want to copy only one of them, click the schedule itself 
to highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Use one of following methods to copy schedules:

 l Right-click to display the menu and select Copy. OR

 l From the tool bar, select the Edit menu, then the Copy option. OR

 l On the keyboard, press Ctrl-C.

 3.  Highlight the cell where the schedules should be pasted.
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 4.  Use one of following methods to paste schedules:

 l Right-click to display the menu and select Paste. OR

 l From the tool bar, select the Edit menu, then the Paste option. OR

 l On the keyboard, press Ctrl-V.

The schedule you copied is now assigned to the highlighted cells.

A schedule can also be copied using the drag-and-drop method. For more information, see Copying and 
Pasting Employee Schedules (on page 86).

Swap From / Swap To
Employee schedules can be swapped between one or more cells, either for the same employee or 
another employee.

Example 

Mary works on Tuesday and David work on Wednesday. You can swap those schedules in one move 
without having to do multiple add and delete actions.

To swap employee schedules, complete the following steps:

 1.  In the schedule grid, highlight the cell or cells to be swapped.

If a cell has more than one schedule and you want to swap only one of them, click the schedule itself 
to highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Use one of following methods to swap schedules:

 l Right-click to display the menu and select Swap From. OR

 l From the tool bar, select the Edit menu, then the Swap From option. OR

 l On the keyboard, press Ctrl-W.

 3.  Highlight the cell or the other schedule involved in the swap.

 4.  Use one of following methods to swap schedules:

 l Right-click to display the menu and select Swap To. OR

 l From the tool bar, select the Edit menu, then the Swap To option. OR

 l On the keyboard, press Ctrl-V.

The schedules are now swapped.
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Paste
The Paste function is used to assign schedules into one or more cells after they were previously cut or 
copied.

For more information and instructions, see Cut (on page 23) or Copy (on page 24).

Tip  

A schedule can also be copied using the drag-and-drop method. For more information, see Copying 
and Pasting Employee Schedules (on page 86).

Delete
The Delete function is used to remove an employee schedule from the grid. Deleted schedules cannot be 
pasted.

To delete employee schedules, complete the following steps:

 1.  In the schedule grid, highlight the cell or cells with the schedules to be deleted.

If a cell has more than one schedule and you want to delete only one of them, click the schedule 
itself to highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Use one of following methods to delete schedules:

 l Right-click to display the menu and select Delete. OR

 l From the tool bar, select the Edit menu, then the Delete option. OR

 l On the keyboard, press Delete.

The schedule is deleted.

Reset Clipboard Data
The Reset Clipboard Data function allows you to clear your computer's clipboard memory. Since certain 
functions temporarily store information in the clipboard, clearing it is helpful in the following types of 
situations.

 l You copied a schedule but meant to cut it.

 l You copied the wrong schedule.

 l You cut a schedule but changed your mind.

 l You accidentally selected Swap From when you meant to select Copy.
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Whenever these types of situations occur, you can clear the computer's clipboard and start over. Reset 
the clipboard by using one of the following methods.

 l Click Edit > Reset Clipboard Data.

 l Right-click anywhere on the schedule grid and select Reset Clipboard Data from the menu. 

Add New Code
The Add New Code option is used to enter a new scheduled activity for an employee. This option is also 
used when you want to add a second activity to the same schedule cell.

Tip  

There are several ways to add schedules for employees. For information, see Adding New Schedules 
(on page 80).

To add a new code to one or more cells, complete the following steps:

 1.  In the schedule grid, highlight the appropriate cell or cells .

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day.

 2.  Use one of following methods to add schedule:

 l Right-click to display the menu and select Add New Code. OR

 l From the tool bar, select the Edit menu, then the Add New Code option.

The outline of an activity box is shown in the cell.

 3.  Type the activity code or pay and press Enter.

 l Activity code: enter the activity code, such as 0700-8

To change the employee's default profile, type the activity code, a delimiter, and the profile 
code. For example, type 0700-8 CH to change from the default RN profile to a Charge profile.

 l Pay code: enter the pay code, start time, and length in hours (all separated by delimiters), such 
as PTO 0000 24 (for PTO starting at midnight and lasting 24 hours)

Leading zeros and colons in the time are not required. For example, these are all acceptable 
entries: 0700, 07:00, 700, and 7:00

A decimal point in the hours value is allowed. For example, these are all acceptable entries: 8, 
8.0, 8.5, and 8.50

Delimiters are characters that separate strings of text or numbers. Delimiters can be spaces, 
commas, or semicolons.

Examples: 0700-8 CH or PTO,0000,24 or PTO;0000;
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Add Transaction Note
The Add Transaction Note function is used to attach a note to an employee schedule. This note can give 
information such as why an employee came in late or left early or any other information.

These notes may be included in certain schedule reports, if the report parameter is set to include them.

To add a note to an employee schedule complete the following steps:

 1.  In the Employee Schedule Grid, highlight the schedule that should have the note attached.

 2.  Open the screen to add a new note using one of the following options.

 l Right-click to open the menu and then select the Add Transaction Note function

 l From the tool bar, open the Edit menu and then select the Add Transaction Note function.

 l On the keyboard, hold down the <Ctrl> button and then click on the T button.

 l Double-click the transaction, then expand the Notes section.
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 3.  The following screen is displayed. The Notes section is near the bottom of this screen.
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 4.  To add a predefined note, click on the icon to the left of the Predefined Note Code field to access a 
menu of existing code options.

 5.  Select an option from the listing. The Subject and Body fields are automatically filled in with the 
values from the predefined note. If the body is editable, additional information can be typed in the 
field.

 6.  If a predefined note is not selected, enter a title for this note in the Subject field.

 7.  In the Body field, enter any information for the note.

 8.  Click Save. Or click Cancel to cancel the creation of this note.

Note  

For more information on predefined notes, see Configuration > System > Predefined Notes.

Publish
The Publish function is used to publish (post) selected schedules on the Schedule screen.

Note  

To publish all the schedules in the open schedule period, go to Schedule > Publish Schedule

To publish one or more employee schedules, complete the following steps:

 1.  In the schedule grid, highlight the cell or cells with the schedules to be published.

If a cell has more than one schedule and you want to publish only one of them, click the schedule 
itself to highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 
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 2.  Use one of following methods to publish schedules:

Note that the Publish option is available only when there is at least one pending schedule in the 
selected cells.

 l Right-click to display the menu and select Publish. OR

 l From the tool bar, select the Edit menu, then the Publish option. OR

 l On the keyboard, press Ctrl-U.

The schedules are now published and appear with bolder borders around them.

View Menu Options
The View option opens a menu of options for viewing or highlighting the schedule. An authorized user can 
also set the current view as the default for all other users.

Highlight
The Highlight function is used to highlight selected scheduled activities, making them easier to identify.

Note  

This functionality is only available when the Highlight option is not selected on the Schedule filter. For 
more information, see Schedule Filters (on page 74).

Clear

Click on the Clear option to clear all the previously selected highlights.

Activities

Select the Activities option to highlight activity codes that meet the criteria of the selected option to the 
left. For example, the user can highlight all activities that are less than 8 hours, activities that are less than 
4 hours, and self scheduled activities.
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Select one of the options from the menu that displays on the right. All schedules that meet the criteria are 
highlighted in the schedule grid.

Calendars

Select the Calendars option to highlight calendars that are set with zero hours. This allows the user to 
add an hour value to these calendars.

The calendars with zero hours assigned are highlighted in the schedule grid.
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Note  

To add an hours value to the calendar, double-click on the calendar box to open the activity and enter 
the hours in the Hours/Unit field. 

Schedule Items
The Schedule Items option allows users to select the types of activities to display on the schedule screen.

Select items to display on the schedule by checking the box to the left of each type of activity to display. 
Click the box to alternately add and remove the check mark. When completed, click on the Apply button 
to apply the filter.

Coverage Sets
The Coverage Sets option allows users to display an alternate view of the staffing coverage, based on the 
coverage periods set up for the coverage set selected from the list.   

A coverage set breaks down a day into defined coverage periods, so that staffing needs and assigned 
staff can be analyzed. For example, a typical coverage set "DEN" breaks down a day into three 8-hour 
coverage periods: Day (7:00-15:00), Evening (15:00-23:00), and Night (23:00-7:00). Another typical 
coverage set DDEENN breaks a day into six 4-hour coverage periods.

Note  

Coverage sets are set up on Configuration > System > Coverage Sets.

The coverage set assigned to the open organization unit is defaulted when the schedule is opened. 
Select an alternate coverage set to display by clicking on the option in the menu. 
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For example, when the DDEENN coverage set is loaded, the balancing grid displays the breakdown of 
coverage into 4-hour coverage period increments.

When the DEN coverage set is loaded, the balancing grid displays the breakdown of coverage into 8-hour 
coverage period increments.

Schedule Notes
The Schedule Notes function opens a screen to view all the schedule notes that were attached to days in 
the open schedule screen.

The user can include schedule notes that were canceled by checking the box to the left of Show 
Canceled Notes in the upper left corner.

 l The user can cancel notes displayed on this screen by checking the box to the left of the note and 
then clicking on the Cancel Selected Notes button.

 l A user can add a new schedule note by clicking on the Add Note button and then completing the 
page.

 l For more information, see Adding a Schedule Note (on the next page).
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Adding a Schedule Note
Schedule notes can be attached to a schedule cell to give more information on the staffing situation for 
that day. For example, this can give information about census, about weather, about holidays or other 
events causing staffing variations.

To add a schedule note, complete the following.

 1.  From the tool bar, select the View menu, then the Schedule Notes function.

- or -

 2.  From the balancing grid, right-click, then the Schedule Notes function.

 3.  Click on the Add Note button at the bottom of the screen.

The Add Schedule Note appears.

 4.  In the Schedule Date field, enter the date where this note should be attached.

 5.  If the note pertains only to a specific coverage period, enter this in the Coverage Period field.

 6.  Select a Predefined Note Code to enter standardized subject and body text. To enter a customized 
note, leave this field blank.

Note  

Predefined notes are previously set up on Configuration > System > Predefined Notes with 
the Schedule Note option set to Yes.
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 7.  In the Subject field, enter a title for this note.

 8.  In the Body field, enter the free-from text for this note.

 9.  When all information has been entered, click on the Save button.

 10.  An icon is displayed in the date header of the balancing grid to indicate there is a schedule note for 
that day.

Canceling a Schedule Note
If authorized, schedule notes can be canceled by the user who entered them or by an administrator. By 
default, canceled notes do not appear on the notes listing or on reports.

To cancel a schedule note, complete the following steps:

 1.  With the cursor in the balancing grid, right-click and select the View Schedule Notes option.

OR

From the tool bar, open the View menu and select Schedule Notes.

 2.  Select the notes to be canceled by entering a check mark in the box to the left of the record. Clicking 
on this box alternately adds and removes the check mark.

 3.  Click on the Cancel Selected Notes button.

The note is now hidden in this screen until the user selects the Show Canceled Notes check box.

Viewing Canceled Schedule Notes

 1.  Authorized users can view notes that have been canceled. Complete the following steps.

 2.  With the cursor in the balancing grid, right-click and select the View Schedule Notes option.

OR

From the tool bar, open the View menu and select Schedule Notes.

 3.  Check the box to the left of Show Canceled Notes.
The canceled notes are displayed. An icon   indicates the note was canceled.
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Styles
The Styles option allows the user to choose whether to display published scheduled activity boxes in solid 
color or transparent with a bold colored border around the box.

Click on the option to set the view.

Solid Style

Transparent Style

 

Note  

The color of the schedule boxes are determined by the color set up for the activity code. This is found 
in Configuration > Scheduling > Activity Codes.

Set Layout As System Default
An authorized user (administrator) can click on the Set Layout As System Default option to set the 
default for new users to be the same as the layout options set up on his or her screen. These options 
include employee grouping, row separators, and zoom level.

Note  

Selecting this function does not change the layout of current users--it only sets the default layout for 
new users.

Once a user logs in, he/she has the option of adjusting any or all of these settings. Those settings are 
saved when the user logs out, and are applied when the user logs back in.
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Tasks Menu Options
The Tasks menu option opens a menu of actions that can be taken for the schedule. Click on an item in 
the menu to open the required screen in the portal.

Review Requests
The Review Requests option opens the Requests tab at the bottom of the schedule screen. From this 
screen, authorized users are able to view and handle requests.

Click on the Select Request Type menu to select the type of request to display. The fields that display 
are determined by the request type selected.

For more information on viewing, filtering, and handling requests, see the Requests (on page 110) 
section in the online help.

Review Employee Schedule Exceptions
The Review Employee Schedule Exceptions option opens the Employee Schedule Exceptions tab at 
the bottom of the schedule screen. From this screen, you are able to view schedule exceptions.

Schedule exceptions, such as violations to minimum scheduling rules, are determined by the Schedule 
Period Validation selection style. 

For more information, see the Employee Schedule Exceptions (on page 121) section in the online help 
and the Minimum Staffing User Guide found on Client Connections.

Call In
The Call In scheduling assistant function opens a wizard used to search for qualified employees to fill a 
schedule opening. Selected employees are then added to the schedule screen.

How it works:

The system first determines which activity codes can fill the need of the schedule opening. Eligible activity 
codes are determined by one of the following methods:

 l By entering the start time and length of the window to search for activity codes (where all hours of 
the activity code fall within that window).

 l By entering a specific activity code.

The system then determines which employees are eligible to work the selected activity codes based on 
the qualification rules, such as Schedule Overlap or Overtime, set up on the specified selection style. The 
scheduling assistant may run multiple passes. For example, the first pass may look for employees who 
are under their approved hours and the second pass for employees under their overtime hours.

Staffing and Scheduling Schedule Screen User Guide

© 2021 symplr. All rights reserved. Page 38 of 121



The process then gives you a list of qualified employees. The employees appear under the activity code 
they are qualified to work and they may appear under multiple activity codes. For example, if the 
scheduling assistant was run for the start time of 07:00 with a length of 8 hours, there might be several 
activity codes that fall within that time frame, such as D4, D6, and D8. All of these activity codes would 
show a list of employees who are eligible to work the activity.

To run the Call In scheduling assistant, complete the following steps:

 1.  In the balancing grid area of the schedule screen, click the cell that indicates the profile, coverage 
period, and date that the scheduling assistant should use.

 2.  Start the scheduling assistant by using one of the following methods:

 l From the tool bar, click Tasks > Call In.

 l From the balancing grid, right-click the appropriate cell. From the menu, select Call In 
Employees.

The Call In scheduling assistant wizard appears.

 3.  Some fields are filled in for you. Update any prefilled fields and enter the necessary information in 
the remaining fields.

 l Mode

The Mode should be Call In. When a cell is understaffed, the Mode defaults to Call In.

 l Selection Style

Selection styles are previously set up in Configuration > Schedule > Selection Styles, with 
the Type set to Scheduling Assistant Call In.
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Built in to the selection style are the qualifications for each of the passes and the sorting rules. 
If you set a personal default selection style or the system has a default selection style, this 
selection style is automatically entered in this field; however, it can be changed.

 l Date, Organization Unit, Profile, Start Time, and Length (Hours)

These fields may be prefilled, based on the cell you highlighted in the balancing grid. These 
values can be changed.

 l Activity Code

Search for and select the appropriate activity code. If there are values in the Start Time and 
Length fields, the values are removed.

Tip  

Use the Start Time and Length fields or the Activity Code field, but not both.

 4.  When all fields are completed, click Next.

 5.  As the process begins, the qualification rules may appear, indicating that field values can be 
changed.

The availability of these fields depends on whether each field is allowed to be viewed or is hidden, as 
set up on the Selection Style.

 6.  Click Next.

 7.  As the process continues, the sorting rules (how the qualifying employees will be ordered) may 
appear, indicating that field values can be changed.

The availability of these fields depends on whether each field is allowed to be viewed or is hidden, as 
set up on the Selection Style.

 8.  Click Next.

A list of qualified employees appears. Employee names appear under each pass that they qualified 
for, listed in the order determined by the sorting rules.
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Tip  

Some employees may qualify for more than one activity code within a pass and for more than 
one pass.

 9.  If desired, click View Results Report.

This creates a report with the qualified employees, their phone numbers, and a place for comments.

 10.  Select the boxes for the employees who will receive the schedule.

 11.  Click Finish.

The selected employees are now assigned the activity code and appears on the schedule.

Call Off
The Call Off scheduling assistant function opens a wizard used to search for employees who are working 
during the selected time frame to identify employees to call off or send home. All or a part of the 
schedules of the selected employees can be removed from the schedule screen and the employees can 
be given an alternate activity code or pay code, such as a low census code.

How it works:

The system first determines which employees are working a schedule that overlaps all or a part of the call 
off time frame. This time frame is determined by one of the following methods:

 l By entering the start time and length of the window to search for activity codes (where all hours of 
the activity code fall within that window).

 l By entering a specific activity code.
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The system then determines which employees are eligible to be called off based on the qualification rules 
set up on the specified selection style. The scheduling assistant may run multiple passes. For example, 
the first pass may look for employees who are over their overtime hours and the second pass for 
employees over their approved hours.

The process then gives you a list of qualified employees. You can select the employees to be called off 
and whether to call off all or a part of the scheduled activities for the employees. You also determine if the 
employees are given a replacement activity code, such as Low Census.

To run the Call Off scheduling assistant, complete the following steps:

 1.  Start the scheduling assistant by using one of the following methods.

 l From the tool bar, click Tasks > Call Off.

 l From the balancing grid, right-click the appropriate cell. From the menu, select Call Off 
Employees.

The Call Off scheduling assistant wizard appears.

 2.  Some fields are filled in for you. Update any prefilled fields and enter the necessary information in 
the remaining fields.

 l Mode

The Mode should be Call Off. When you start the Call Off wizard, the Mode defaults to Call Off.

 l Selection Style

Selection styles are previously set up in Configuration > Schedule > Selection Styles, with 
the Type set to Scheduling Assistant Call Off.
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Built in to the selection style are the qualifications for each of the passes and the sorting rules. 
If you set a personal default selection style or the system has a default selection style, this 
selection style is automatically entered in this field; however, it can be changed.

 l Date, Organization Unit, Profile, Start Time, and Length (Hours)

These fields may be prefilled, based on the cell you highlighted in the balancing grid. These 
values can be changed.

 l Activity Code

Search for and select the appropriate activity code. If there are values in the Start Time and 
Length fields, the values are removed.

Tip  

Use the Start Time and Length fields or the Activity Code field, but not both.

 3.  When all fields are completed, click Next.

 4.  As the process begins, the qualification rules may appear, indicating that field values can be 
changed.

The availability of these fields depends on whether each field is allowed to be viewed or is hidden, as 
set up on the Selection Style.

 5.  Click Next.
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 6.  As the process continues, the sorting rules (how the qualifying employees will be ordered) may 
appear, indicating that field values can be changed.

The availability of these fields depends on whether each field is allowed to be viewed or is hidden, as 
set up on the Selection Style.

 7.  Click Next.

A list of qualified employees appears. Employee names appear under each pass that they qualified 
for, listed in the order determined by the sorting rules.

Tip  

Some employees may qualify for more than one activity code within a pass and for more than 
one pass.

 8.  If desired, click an employee name to see the employee's contact information.

 9.  For the employees you would like to remove from the schedule, click the drop-down menu in the 
Replace/Remove column.

Several options appear, such as All, Overlap, Beginning, and End.
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If you leave the drop-down menu blank, the employees are not affected by the rest of your actions in 
the wizard and their schedules are not affected.

 10.  Select an option from the menu, depending on whether you want to replace all or part of the 
schedule with a different activity code or pay code or to remove the schedule from the schedule 
screen.

Replace/Remove 
Option Result*

All Removes the entire schedule or replaces the entire schedule with a new 
activity.

Overlap Removes or replaces the part of the schedule that overlaps the call off 
time frame selected in step 2.

Beginning Removes or replaces the part of the schedule that overlaps the call off 
time frame and removes the part of the schedule that occurs before the 
call off time frame.

End Removes or replaces the part of the schedule that overlaps the call off 
time frame and removes the part of the schedule that occurs after the 
call off time frame.

*To determine whether to remove or replace the schedule, the system uses the option you choose in 
this step along with your decisions in step 12.

 11.  Click Next.

 12.  Enter a replacement Activity Code or Pay Code, or leave the fields blank to remove the original 
schedule.

 l If you enter a code, all or part of the original schedule will be replaced, based on your selection 
in step 10.

 l If you leave the fields blank, all or part of the original schedule will be removed, based on your 
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selection in step 10.

Tip  

For help in understanding your choices, see the following table.

 13.  Click Finish.

The affected employees' schedules are removed or replaced.

The following table explains how the selections you have made throughout the previous steps will affect 
the original schedule. The Call Off Time Frame in the final column is based on your selection in step 2.

Option 
Selected in 
Step 10

Decision 
Made in 
Step 12 Result

All Leave 
fields 
blank

Entire schedule is removed

All Enter an 
activity or 
pay code

Entire schedule is changed to the new code

Overlap Leave 
fields 
blank

The part of the original schedule that overlaps the call off time frame is 
removed, leaving any scheduled time before and after the call off time 
frame unaffected.

Overlap Enter an 
activity or 
pay code

The part of the original schedule that overlaps the call off time frame is 
replaced, leaving any scheduled time before and after the call off time 
frame unaffected.

Beginning Leave 
fields 
blank

The part of the original schedule that overlaps the call off time frame and 
the time before the call off time frame are removed. Any scheduled time 
after the call off time frame is not affected.

Beginning Enter an 
activity or 
pay code

The part of the original schedule that overlaps the call off time frame is 
replaced and the time before the call off time frame is removed. Any 
scheduled time after the call off time frame is not affected.

End Leave 
fields 
blank

The part of the original schedule that overlaps the call off time frame and 
the time after the call off time frame are removed. Any scheduled time 
before the call off time frame is not affected.

End Enter an 
activity or 
pay code

The part of the original schedule that overlaps the call off time frame is 
replaced and the time after the call off time frame is removed. Any 
scheduled time before the call off time frame is not affected.
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Apply Staffing Template
The Apply Staffing Template function opens a screen to select and assign a staffing template to the 
staffing plan for all or part of the open schedule, assuming that a staffing template has not already been 
applied.

The values set up in the staffing template are replicated to fill all weeks of the schedule. For example, if 
the staffing template is set up for one week, the template is replicated four times to fill a 4-week schedule.

This option is only available when the schedule for a single organization unit is open; it is hidden when a 
schedule group is open.

To apply a staffing template to a schedule, complete the following steps:

 1.  From the tool bar, click Tasks and then click Apply Staffing Template.

The Apply Staffing Template dialog box appears.

 2.  Enter the Start Date and End Date of the date range to have the staffing template reapplied. The 
start and end dates of the open scheduling period are automatically loaded, but can be changed, as 
long as they fall within the scheduling period of the open schedule.

 l To apply a staffing template to a date range outside the range of the open schedule, close this 
screen, open the schedule to a date range which includes the entire date range to apply, and 
then reopen this function.

 l If the date entered in the Start Date field is earlier than the current date, a message is 
generated to select which staffing values are updated. See step 7 below for more information.

 3.  The Staffing Template Code value displays the default staffing template, but another template can 
be selected. 
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Note  

The Default staffing template is selected on the Staffing Template screen for the open 
organization unit. For more information, see Configuration > Scheduling > Staffing 
Template.

 4.  The Start Week number indicates which week of the template should be aligned with the first week 
defined in the Start/End date fields. This number defaults to 1 but can be updated.

 5.  When the fields are all configured, click Save.

 6.  If the Start Date field contains a date that is before the current date, the following message appears, 
"The start date you have entered is in the past. This action may result in overwriting existing data."

 l If Yes is selected, the system will apply the values in the Staffing Template to all dates within 
the selected date range, including dates in the past. Therefore, any staffing values that were 
previously updated (either manually or by using the Recalculate Staffing Needs wizard) will be 
overwritten with the Staffing Template values, and the updates will be lost.

 l If No is selected, the system will apply the values in the Staffing Template to all dates in the 
range that fall on or after the current date. Any values in the staffing plan previous to the current 
date will not be updated. Therefore, any staffing values that were previously modified (either 
manually or by using the Recalculate Staffing Needs wizard) will not be affected.

 l If Cancel is selected, the wizard is closed and no values are updated.

 7.  When the action is complete, the schedule screen is reloaded. The updated staffing template values 
are accessible from the Balancing Grid section of the schedule.

Note  

From this screen, only existing staffing templates can be loaded to the staffing plan. To manually 
update any of the values for the staffing plan, go to Action > Schedule > Staffing Plan. Open 
the staffing plan for the required organization unit and scheduling time frame. Click on the Open 
Staffing Plan button, make modifications to the displayed grid and save the record. The values 
are updated to the schedule needs grid.

Open Staffing Plan
The Open Staffing Plan function opens a screen to view and/or edit the staffing levels needed for each 
day of the scheduling period. These staffing need values are set up by profile and coverage period.

The baseline (projected) staffing need values for an organization unit are usually loaded from the Staffing 
Template. The actual staffing need values can be adjusted either before or after the actual scheduling 
period days.  

 l The projected staffing needs can be increased for a holiday, based on historical requirements. 
These adjustments can be made before the schedule population is run to include additional staff.
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 l The actual staffing needs based on patient census and acuity can be adjusted on or after the 
schedule day by using the Recalculate Staffing Needs wizard. The updated staffing need values are 
displayed in this Staffing Plan screen. 

To open the staffing plan to add, edit, delete, or view the values, complete the following steps:

 1.  Open the Schedule screen to the labor distribution and date range to be adjusted.

 2.  From the tool bar, open the Tasks menu, then the Open Staffing Plan function.

The grid appears showing the profile and coverage period, and the staffing needs set for each day.

 3.  To change any of the required staffing level values for any days, highlight the cells and type in the 
new staffing values in whole and decimal numbers.

 4.  To add new profile/coverage period combinations to the plan, complete the following steps

 a.  Click on the bottom line of the plan.

 b.  Select a profile from the drop down menu.

 c.  Select a coverage period from the drop down.

 d.  Enter the staffing needs for each day of the entire scheduling period displayed.

 5.  To delete an entire line in the staffing plan, complete the following steps:
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 a.  Click the row to highlight the entire line.

 b.  Click Delete.

 c.  A message appears verifying the deletion should continue. Select Yes.

 6.  When modifications to all fields have been completed, click on the Save button.

These new values are automatically loaded to the Balancing Grid.

Note  

To reload the original staffing values after the updates have been saved, click on the Apply 
Staffing Template button in the left pane. Enter the start and end dates of the date range to be 
restored and the staffing template code to be loaded. For more information, see Apply Staffing 
Template (on page 47). 

Recalculate Staffing Needs
The Recalculate Staffing Needs function opens a wizard used to update required staffing levels for an 
organization unit. You enter actual patient census, based on acuity levels, and the system recalculates 
the required staffing levels.

Authorized users can also use this screen to manually update the staffing needs for a specific profile, with 
or without changing the census values.

Note  

The Staffing Distribution screen must be set up to calculate the new staffing levels. This screen is 
located in the Configuration > Scheduling > Staffing Configuration > Staffing Distribution table.

To recalculate the staffing needs of an organization unit, complete the following steps:

 1.  Start the wizard by using one of the following methods.

 l From the tool bar, click Tasks > Recalculate Staffing Needs.

 l From the balancing grid, right-click the appropriate cell. From the menu, select Recalculate 
Staffing Needs.
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The Recalculate Staffing Needs wizard appears and the organization unit and date are filled in.

 2.  If needed, update the organization unit and date fields and then click Next.

The next screen of the wizard differs depending on the Census Category selected when you created 
the organization unit's Staffing Configuration. The Census Categories are:

 l Staffing by Lookups

 l Staffing by Profile

 l Staffing by Hours

 l Staffing by Ratios

Note  

The following steps use Staffing by Lookups, since this is the most common Census 
Category. However, explanations are provided where there are differences if you use one of 
the other three categories. Most of the steps are the same regardless of the Census 
Category.
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Recalculate Staffing Needs wizard using Staffing by Lookups

 3.  For each coverage period, enter the unit's census value for each acuity level in the Calculating 
Parameters column.

These values are used to recalculate the staffing needs.
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Note  

Explanations for other Census Categories

 l Staffing by Profile: Enter the number of hours for each Profile Group for each acuity level in 
the Calculating Parameters column. The hours are distributed to each profile based on the 
Profile Percent Value for each profile within the Profile Group, as configured on the Staffing 
Distribution table. Note: The profile hours are often calculated by a third-party acuity and 
patient classification system and may be automatically downloaded into Staffing and 
Scheduling.

 l Staffing by Hours: Enter the number of hours for the organization unit for each acuity level 
in the Calculating Parameters column. The hours are distributed to each profile based on the 
Profile Percent Value, as configured on the Staffing Distribution table. Note: The hours are 
often calculated by a third-party acuity and patient classification system and may be 
automatically downloaded into Staffing and Scheduling.

 l Staffing by Ratio: Enter the beginning census and the number of admissions, discharges, 
and transfers in the Calculating Parameters column. The net census value is multiplied by 
the Hours Per Patient Day value and then distributed between the coverage periods based 
on the Coverage Period Percent Value. Then the hours are distributed to each profile based 
on the Profile Percent Value, as configured on the Staffing Distribution table.

 4.  If there are fields available in the Reporting Parameters column, enter values in each field.

These values are used for reporting purposes only and do not impact the calculation of staffing 
needs.

 5.  To add a note to this adjustment, click the New Note tab.

The note can be either an existing predefined note or a custom note.

 a.  To search for and select a predefined note, click  .

 b.  Enter a Subject.

If a predefined note was selected, the subject is automatically filled in, but it can be changed.

 c.  In the Body field, enter the text of the note.

If a predefined note was selected, the body text is automatically filled in. If allowed, the text can 
be changed.

 6.  Click Next.

The recalculated staffing needs appear for each coverage period and profile.
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You may need to open a card by clicking   to view the Adjustment Value and Adjustment Reason 

fields.

Tip  

The following optional step is only used if the recalculated needs do not adequately meet the 
unit's actual needs. In this situation, you can manually override the recalculated needs.

 7.  Optional. Enter a value to adjust the needs and enter a reason for the adjustment.

Note  

This value is not the actual need. It is the value needed to get to the new need.

Example 

The recalculated need is now 5.00. But you feel that the need should be 6.00. Enter 1 (not 6).

The recalculated need is now 5.00. But you feel that the need should be 3.00. Enter -2 (not 3).

 8.  Click Finish.

The Balancing Grid on the schedule screen is updated with the recalculated needs for the selected 
day.
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View Calculated Data
The View Calculated Data option opens a wizard used to generate information about a clocking pair, a 
schedule, or an adjustment for the selected employee and day.

Example 

For a clocking pair, the details may include the in and out punches for the calculated lunch break, the 
start of a different pay code, such as a weekend or holiday differential, or a change in labor 
distribution.

To view the calculated data, complete the following steps:

 1.  In the schedule grid, select a cell for the employee and date for which you would like to view 
calculated data.

 2.  View the calculated data by using one of the following methods.

 l From the tool bar, click Tasks > View Calculated Data.

 l From the balancing grid, click the View Calculated Data tab.

Image shows an example of clocking calculated data

Image shows an example of calendar calculated data

 3.  To view additional details, click a row of information to expand it.

Example 

In the previous image of the clocking calculated data, the in punch on 2/4/11 is collapsed, 
showing summary information. The out punch on 2/5/11 was clicked and is now expanded so 
that you can see detailed information.
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 4.  As needed, click the other tabs to view additional information.

The following table explains the type of information found on each tab.

Tab Type of Information

Actual Displays actual calculated data based on the employee's calendar and clocking 
information.

Scheduled Displays the hours calculated by the Time and Attendance Calculations 
process for only the scheduled hours. Actual clockings are not included in 
these calculations.

Projected Displays the hours that are projected by the Time and Attendance Calculations 
process, based on actual clocking and calendars and future calendars. This 
would be an employee's total hours, assuming the employee works the hours 
scheduled to work.

Projections are only calculated for pay codes that have the Pay Code indicator 
Calculations Standard 6 set to Yes. Also make sure that organization unit 
indicator Calculations Standard 4 "Projected Payment Determination" is 
enabled.

Column Explanations
Source

The symbol lets you know the type of transaction. 

 - Clocking (either manual or from an input device or badge reader)

 - Calendar (either a scheduled activity code or a calendar submitted for time off)

 - Adjustment (a manager has created a transaction to make an adjustment for the employee)

Overtime

A check mark appears if the process determines there will be an overtime situation. This occurs for pay 
codes that are set up to be considered overtime pay codes, that is, those with Pay Code indicator System 
Standard 2 set to Yes.

In Date

The date that the employee transaction began.

In Time

The time that the employee transaction began.

Out Date

The date that the employee transaction ended.
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Out Time

The time that the employee transaction ended.

Net Hours

The number of hours between the In Time and the Out Time. For clockings, the Net Hours do not include 
lunch length.

Pay Code

Displays the pay code associated with the transaction. For calendars, this field usually shows SCHED.

Direct/Indirect

Whether the transaction is considered direct or indirect, as set on the pay code.

Organization Unit

Displays the organization units where the transaction is clocked or scheduled.

Pay Period Date

The first date of the pay period that this transaction is calculated for.

Job Class

The work assignment, such as registered nurse, for the transaction.

Position

The position (the combination of the job class and organization unit) for the transaction.

N/P

Whether the transaction is considered non-productive or productive, as set on the pay code.

Cost

The cost, in dollars, for the time frame shown.

Set Schedule for Bidding

Note  

Schedule Incentive is a separate module. If your organization does not have Schedule Incentive, this 
option will not be visible.

To set a schedule for Schedule Incentive, complete the following steps.

 1.  Open the schedule screen for the appropriate date range and organization unit.

 2.  In the Balancing Grid, select the shifts to be offered through Schedule Incentive.

You can select multiple shifts on multiple days (hold CTRL while clicking) to set up incentives for all 
shifts at the same time.
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Note  

You will only be able to select days that are within the Default Days Before Create parameter on 
the Staffing Configuration screen.

Example 

The Default Days Before Create parameter is set to 45 days. You will only be able to set up an 
incentive schedule up to 45 days before the date of the shift. If the shift is 46 days away, you 
cannot yet set up the incentive schedule.

 3.  Right-click on a selected schedule or click the Tasks menu.

 4.  Select Set Schedule for Bidding.

The Incentive Schedule Wizard appears.

Continue creating an incentive schedule by completing the instructions in the following Flat Dollar 
Method (below) or Percentage Method (on page 60) section.

Flat Dollar Method
General Card

Many fields in the Schedule Incentive Wizard have information already filled in. This information came 
from various sources, such as the Staffing Configuration.

 1.  In the Classification field, select Flat Dollar.

 2.  In the Auto Approve field, select the approval method.
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 l To allow the employee with the lowest Schedule Incentive offer to automatically receive the 
schedule when the Close Date and Close Time pass, select Yes. The manager does not have 
to approve the Schedule Incentive request.

 l To require the manager to approve the Schedule Incentive request even after the Close Date 
and Close Time pass, select No.

 3.  In the Activity Code field, enter an activity for the incentive schedule.

 l Type an activity code or click   to select the code from a list.

Only the activity codes configured for Schedule Incentive appear in the list.

 4.  If needed, enter or update the Open Date, Open Time, Close Date, and Close Time.

These values determine when the shift is available to employees to request.

 5.  If needed, edit the Shift Count.

This number is the same as the Need on the Balancing Grid. For example, if the Need is 2, the Shift 
Count is 2.

 6.  The Start Time, Hours/Units, and Lunch Length values default to the values associated with the 
selected activity code.

 7.  Enter a Maximum Bid or Minimum Bid, which represent the highest or lowest dollar amount 
acceptable for this incentive schedule.

 8.  Enter an Increment value to indicate the minimum dollar increment that employee Schedule 
Incentive requests must meet.

 9.  Click Save.

Organization Open Dates Card

The fields on this card are optional.
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 1.  Open the Organization Open Dates card.

The fields allow you to expand the Schedule Incentive offer to other organization units. This allows 
other employees to request shifts that were not requested by employees in the original organization 
unit or shifts with requests that have not yet been approved.

The values indicate the number of days before the shift and the time of day that the shift becomes 
available to employees to start requesting. The fields may already be filled in with dates and times 
from the Staffing Configuration. You may fill in empty dates and times or change the dates and times 
that are already filled in.

 2.  Click Save.

Overrides Card

The fields on this card are optional.

 1.  Open the Overrides card.

The fields allow you to expand the pool of employees available to request the incentive schedule by 
removing restrictions.

The override options, such as Positions or Stations, show what qualifications an employee needs to 
have to work this shift. However, if you need to expand the pool of employees to fill this shift, you can 
remove some qualifications. You cannot add qualifications.

Example 

You may want to remove a certain license or educational requirement to increase the number of 
employees available.

 2.  Click the appropriate override options and then click the boxes to remove the desired requirements.

 3.  Click Save.

Percentage Method
General Card

Many fields in the Schedule Incentive Wizard have information already filled in. This information came 
from various sources, such as the Staffing Configuration.
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 1.  In the Classification field, select Percentage.

 2.  In the Auto Approve field, select the approval method.

 l To allow the employee with the lowest incentive offer to automatically receive the schedule 
when the Close Date and Close Time pass, select Yes. The manager does not have to 
approve the Schedule Incentive request.

 l To require the manager to approve the Schedule Incentive request even after the Close Date 
and Close Time pass, select No.

 3.  Do not enter an activity code in the Activity Code field.

Note  

Separate activity codes were created, such as SI10, to work with the Percentage method. The 
system automatically determines the correct activity code to attach to this schedule based on the 
other entries made in the Schedule Incentive Wizard.

 4.  If needed, enter or update the Open Date, Open Time, Close Date, and Close Time.

These values determine when the shift is available to employees to request.

 5.  If needed, edit the Shift Count.

This number is the same as the Need on the Balancing Grid. For example, if the Need is 2, the Shift 
Count is 2.

 6.  Enter or edit the Start Time, Hours/Units (the length of the shift), and Lunch Length values.

The Start Time and Lunch Length may default to the values associated with the shift selected for the 
incentive schedule.
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 7.  Enter a Maximum Bid or Minimum Bid, which represent the highest or lowest dollar amount 
acceptable for this incentive schedule.

 8.  The Increment field is not used with the Percentage method. Leave blank.

 9.  Click Save.

Organization Open Dates Card

The fields on this card are optional.

 1.  Open the Organization Open Dates card.

The fields allow you to expand the Schedule Incentive offer to other organization units. This allows 
other employees to request shifts that were not requested by employees in the original organization 
unit or shifts with requests that have not yet been approved.

The values indicate the number of days before the shift and the time of day that the shift becomes 
available to employees to start requesting. The fields may already be filled in with dates and times 
from the Staffing Configuration. You may fill in empty dates and times or change the dates and times 
that are already filled in.

 2.  Click Save.

Overrides Card

The fields on this card are optional.
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 1.  Open the Overrides card.

The fields allow you to expand the pool of employees available to request the incentive schedule by 
removing restrictions.

The override options, such as Positions or Stations, show what qualifications an employee needs to 
have to work this shift. However, if you need to expand the pool of employees to fill this shift, you can 
remove some qualifications. You cannot add qualifications.

Example 

You may want to remove a certain license or educational requirement to increase the number of 
employees available.

 2.  Click the appropriate override options and then click the boxes to remove the desired requirements.

 3.  Click Save.

Link to Employees
The Link to Employees function opens the portal to the employee record section. Authorized users can 
then view or edit any of the information in the employee record.

 l The records of all the employees included in the open schedule grid are opened. 

 l If a filter is applied when this function is selected, only the employees included in the filter are 
opened.  

 l The employee records are displayed in the order that they are listed on the schedule screen. 

You can move between the open employee records using the arrows in the Employee Navigator.

Note  

To open the record of a single employee, highlight the employee name, right-click and select the Link 
to Employee option from that menu. This action can be done multiple times with different employees, 
creating a group of employees in the portal that you can navigate through.

Help Menu Options
The Help menu opens a screen to view a Legend of the icons used in the schedule grid, to access the 
online help file, and also to view the About screen, which gives release information about the software 
and trademark and copyright information.
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Legend
The Legend option displays the icons that are shown in the schedule grid.

Help
Click on the Help option to open the online help documentation for this feature.

The online help contains overview information of the screens, step by step directions for actions, an 
index, and a search screen to search for topics.

For more information on the features and functionality available in this file, see Help Menu Options (on 
the previous page).

About
The About option opens a screen which shows the version release of the software. The copyright and 
trademark information are also displayed.
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Scheduling Period Navigator
The Scheduling Period Navigator can be used to go to the next scheduling period or to the previous 
scheduling period for the open organization unit. The start and end dates of the scheduling period that is 
currently open is displayed.

 l To go to the next scheduling period, click on the arrow pointing to the right  .

To go to the previous scheduling period, click on the arrow pointing to the left  .

To view a schedule for a different organization unit or schedule group, from the tool bar, open the 
Schedule menu, then the Open option. A screen is displayed to search for and select the schedule.
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Employee Information
The Employee Information area displays the employee names and other selected information. These 
columns of information can be displayed on the schedule grid, or as a tool tip (when the cursor is hovered 
over the employee name), or both.

 l The employee columns that are displayed are selected on the Show/Hide Details screen accessed 
from the right-click menu. Columns can be resized by dragging the column dividers.

Tip  

Click a column header to re-sort the information by that column. Press <CTRL> and click column 
headers to sort by multiple columns.

 l Employee names can be separated by Group Headers to divide them into groups with the same job 
class, shift, employee class, home distribution, or employee status.

 l Employee Schedule Exception icon 

If you do not see the Exceptions column, you can add it. For information, see Show/Hide Details (on 
the next page).

This symbol indicates that the employee has at least one schedule exception. Schedule exceptions, 
such as violations to minimum scheduling rules, are determined by the Schedule Period Validation 
selection style.

The Employee Schedule Exceptions tab near the bottom displays all the employees who have 
exceptions. If you click   on an employee row, the Employee Schedule Exceptions tab displays 

only the exceptions for the selected employee and the employee's name is entered in the filter box. 
To remove the filter to view all the employee exceptions, click the X in the filter box.

Group Headers (Employee Information Section)
The Group Headers are displayed in the Employee Information area to separate employees into groups. 
These groups can be by job class, shift, employee class, home distribution, or employee status. The user 
may choose not to use any headers (none) so all employees are sorted together.

 l Group headers are selected from a menu accessed by right-clicking. Select the Group By (on the 
next page) option to display a listing of options.  

 l The groups can be expanded to show the employees in that group or they can be collapsed to hide 
them. Clicking on the header alternately expands (shows) and collapses (hides) the employees in 
the group. The number of records contained in a group is displayed in parentheses after the group 
name.

 l You can drag a group to a different spot in the list so that you can have commonly-used groups near 
the top. The new group order remains the next time you open the Schedule screen.
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 l Within a group, you can drag an employee to a different spot in the employee list so that you can 
have, for example, charge nurses or supervisors near the top. The new employee order remains the 
next time you open the Schedule screen.

If you had added a row separator (see Add Row Separator (on page 71)), the row separator remains 
with the employee, even as you move that employee or other employees to different spots. Because 
of this, after moving an employee to a different spot, you may need to remove the existing row 
separator and add a new one in the desired location.

Employee Information Right-Click Menu
Additional options are available for customizing the Employee Information area. A menu is accessed by 
right-clicking within the Employee Information area.

Group By
The Group By option opens a screen where the user can select the header for grouping the employee 
names.

To access this menu, position the cursor in the employee information section and right-click.

Select the group option from the menu by clicking one of the following options:

Job Class Groups employees by the Job Class Code entered in their Primary Home Labor 
Distribution screen in the employee record, such as RN, LPN, or Cook.  

The headers will display the Job Class abbreviation if one is set up on Job Class 
Parameter System Standard Alpha 1. They will display the job class number if no 
abbreviation is set up.

Shift Groups employees by the Shift Code entered in their Primary Home Labor 
Distribution screen in the employee record, such as 1st, 2nd, or 3rd.

Employee 
Class

Groups employees by the Employee Class Code entered in the Primary Home Labor 
Distribution screen in the employee record, such as Full Time, Part Time, or Temp.

Home 
Distribution

Groups employees by the Organization Unit Code entered in their Primary Home 
Labor Distribution screen in the employee record, such as facility 06-Department 
2030.

Status Groups employees by the Status Code entered in their Primary Home Labor 
Distribution screen in the employee record, such as Active, Inactive, Terminated.

Show/Hide Details
The Show/Hide Details option opens a screen for you to select which columns to display in the Employee 
Information area and/or in a tool tip that appears when the cursor is hovered over the employee name.
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Tip  

Click a column header to re-sort the information by that column. Press <CTRL> and click column 
headers to sort by multiple columns.

To select the employee information columns that appear, complete the following steps.

 1.  Position the cursor in the Employee Information area.

 2.  Right-click and select the Show/Hide Details option.

The following dialog box appears.

 3.  To select an option, click the box to the right of the option.

You need to have at least one option selected.

 l To include the field in the Employee Information area, check the box in the Display in List 
column.

 l To include the field in the tool tip, check the box in the Display in Popup column.

 l To include the field in both the Employee Information area and the tool tip, check the box in 
both columns.
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Tip  

The Info option indicates one of the following situations: the employee is a relief employee, 
the employee does not have position permissions, or the employee has a termination date 
before or during the current scheduling period. The employee information flag   appears 

on the schedule screen in the Info column.

 4.  When finished, click Close to save the selections.

Add Employees
Click on the Add Employees option to open a screen to search for and select employees to be added to 
the schedule. 

Note  

You can search only for employees you have access to.

Once the employee name is added to the schedule, the user can schedule activities for the employee.
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Create Employee Schedule
The Create Employee Schedule function opens a wizard used to run the scheduling process for a single 
employee.

To create an employee schedule, complete the following steps:

 1.  Click the name of the employee whose schedule you are creating.

The employee row is highlighted.

Tip  

If you do not click an employee name first, the first employee listed on the schedule screen is 
automatically selected.

 2.  From the tool bar, click Schedule > Create Employee Schedule.

The Create Employee Schedule wizard appears.

 3.  Some fields are filled in for you. Update any prefilled fields and enter the necessary information in 
the remaining fields.

 l Start Date and End Date

The dates for the open schedule period appear but can be changed; however, both dates must 
fall within the open schedule period.

 l Selection Style

The default Selection Style appears, but a different one can be selected.

 l Create Schedule Audit Report
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This option, when set to Yes, generates a report that tracks whether the employee was 
scheduled and any reasons that disqualified the employee from being scheduled. This report is 
viewed in the Reports > Scheduling > Create Schedule Audit Report.

 4.  Click Finish.

When the process finishes, the schedule screen is updated with the results of the scheduling 
process.

Link To Employee
The Link to Employee option opens up the employee record in the portal. This allows the user to add, edit, 
or view employee information. This action can be done multiple times with different employees, creating a 
group of employees in the portal that you can navigate through.

Note  

The records of all the employees in the schedule (or only those included in a filter) can be accessed by 
selecting the Tasks menu in the tool bar, then clicking on the Link to Employees (on page 63) function. 
This action clears any previously selected single employee or group of employees.

Validate Employee Schedule
This options allows you to validate employee schedules immediately. Validations in the balancing grid at 
bottom of screen update every minute.

Add Row Separator
The Add Row Separator option is used to insert a line on the Schedule screen. This can be used as a 
visual separator within the schedule grid (for instance, between full time and part time employees).

If you add a row separator, it remains with the employee, even as you move that employee or other 
employees to different spots in the employee list (see Group Headers (Employee Information Section) 
(on page 66). Because of this, after moving an employee to a different spot, you may need to remove the 
existing row separator (see Remove Row Separator (below)) and add a new one in the desired location. 

Remove Row Separator
The Remove Row Separator option is used to remove a row separator that was previously inserted on the 
Schedule screen. This option is only enabled when the row above the separator is selected or you right-
click on the row above.
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Schedule Grid
The Schedule Grid section displays the pending and published activities, classes, unavailability, 
calendars for each employee with a valid labor distribution record in the open record. This includes 
primary home, alternate home, and/or alternate labor distribution records.

 l The Employee Information area displays selected information, such as employee name, phone 
number, approved hours, or scheduled hours. This information is selected from a menu displayed by 
a right-click when the cursor is in the section.  

 l The Group Headers can be set up to group employees by job class, shift, employee class, home 
distribution, or employee status.

 l The Date Headers (on page 78) display the day of the week and the date for each day in the open 
schedule. If the date is a holiday, the holiday name replaces the day of week.

 l The Schedule Cells (below) display the scheduled activities, education tracking classes, 
unavailability/recurring unavailability, or calendars. for each employee, for each day of the open 
schedule.

Schedule Cells
There is an individual schedule cell for each day, for each employee. The schedule cells display the 
scheduled activities, unavailability, and education tracking classes for each day.

Scheduled Activity Boxes

The individual boxes within the schedule cells show the scheduled assignment for that day. The following 
may be displayed on a schedule:

Icon Type Description

 

Published 
Schedule

 l Transparent 
Style

 l Solid Style

Depending on the Style selected, a published schedule is either 
indicated by a bold border and font or by the activity box being filled in 
with the selected activity color.

To change the style, go to the tool bar, then open the View menu, 
then the Style option. Select either the Transparent Style or the 
Solid Style.

Pending Schedule The muted border and font indicate that this schedule is pending.

Alternate 
Schedule

The heavy border on the left side of the schedule box indicates the 
employee is scheduled in an organization that is not included in the 
open schedule screen. Hover the cursor over the schedule box to 
display a tool tip with the details about the schedule, including the 
organization unit and profile assignments.
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Icon Type Description

Highlighted 
Schedule

The gold coloring indicates this schedule is highlighted. Schedules 
are selected for highlighting from Tool Bar > View > Highlight>  
Activities, then choose the type of activities to be highlighted.

Overtime 
Schedule

The red background indicates that this schedule will cause the 
employee to incur overtime. If schedules are projected in the future, 
this gives the scheduler time to reschedule the employee before 
he/she actually incurs overtime.

Cursor Focus on 
an Empty Cell

The dark gray border indicates that the focus has been set on this 
empty cell.

Cursor Focus on a 
Filled Cell

The gray border around the outside of the scheduled activity box 
indicates the focus is set on this cell.

Calendar Entry  The black, oval shaped icon indicates a calendar. The calendar code 
is displayed in the center.

  Education 
Tracking Class

Instructor

Approved

Requested

The gray, oval shaped icon indicates the employee is enrolled in an 
education tracking class on this day. ED is displayed on the icon. 
Hover the cursor over the icon to display a tool tip with information on 
the class.

Extra Shift The Extra Shift indicator determines whether a shift is an extra shift or 
a regular shift. 

Note  

The Extra Shift indicator is only displayed for pending/published 
schedules. 

  Unavailability

 l Approved

 l Requested

The green bar indicates the employee has an unavailability request 
on the day(s) it is displayed. If there is a yellow star on the bar, this is 
a pending request.

  Recurring 
Unavailability

 l Approved

 l Requested

The green bar with a circling arrow indicates the employee has a 
recurring unavailability request on the day(s) it is displayed. If there is 
a yellow star on the bar, this is a pending request.

Schedule 
Incentive Request

This icon indicates that the employee has submitted a schedule 
incentive bid for the day.
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Formatting Options of Cells

The information that is displayed within the scheduled activity box can be formatted to display one of the 
following options. The following show the information that is displayed for the same schedule.

Option Example Description

Activity Shows the scheduled activity code only.

Activity Profile

 

Shows the activity code and the profile of the schedule.

Times Shows the starting and ending times of the schedule.

Times Profile

 

Shows the starting and ending times and the profile of the schedule.

Schedule Filters
A filter can be created and applied to limit the employees displayed in the screen. The filters can be by 
information in the schedules or employee information. For example, a filter can be applied to display only 
the RN's who are scheduled for activities that provide coverage on the day shift.

The schedule filter section is found at the top of the screen on the right side.

When a filter is loaded, only employees meeting the conditions of the filter are displayed. If the Highlight 
Matched Results check box is checked, the schedules that meet the filter criteria are highlighted in gold.
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Filter Icons

The following icons are displayed on the Filter section:

Icon Type Description

Expand/Collapse 
Filter Options

Click on this icon to display or hide the fields to add criteria to the 
schedule filter. 

Add a New 
Condition

Click this icon to add a line for entering a filter condition.  For more 
information on filtering conditions, see Creating a New Schedule Filter 
(below).

Clear/Remove 
Condition

Click this icon to remove the condition line to the left of this icon.

Look Up Values Click on this icon to open a menu of valid values for the selected field.

Load Filter Click on this icon to view a drop down menu of existing filters. Click on 
the filter name to load that filter.

Delete Filter Click on this icon to view a listing of existing filters. Click on the filter 
name to delete that filter.

Save Filter Click on this icon to save the filter. A box will display to enter a name 
for this filter.

Creating a New Schedule Filter
New schedule filters can be created by authorized users. These filters can be saved and used again.

To create a new schedule filter, complete the following steps:

 1.  With the schedule screen open, navigate to the upper right side of the screen.

 2.  Click on the expand icon   to display the fields for setting up a new filter.
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 3.  In the Field Selector field, click on the icon to display the menu options for this field.

 l Select the field to include in the filter from the menu. This field may be from the employee 
schedule or from the employee record.

 l If the Any Field option is chosen, any of the fields in this menu can match with the values set 
up in the Field Values field.

 l Note that the Coverage Period filter only shows schedules that count toward coverage during 
the selected coverage period. For example, a productive schedule that overlaps the coverage 
period would appear, but a PTO calendar would not.

 4.  In the Condition Operator field, open the menu and select the option to determine how the field 
criteria needs to be met.

The following lists the operator options.

Note  

Some fields only allow a certain operator, such as Equal To. This operator is then automatically 
assigned and cannot be updated.

Operator Description

Contains The employee or schedule must include the value entered in the Field Value 
field. For example, if the Field Selector is Job Class and the user types "nurse" in 
the Field Value field, the filter will include all job classes that have "nurse" in the 
description.

Equal To The employee or schedule must match one of the values selected in the Field 
Value field.

Begins 
With

The value in the Field Selector begins with the letters or numbers entered in the 
Field Values field. 

Does Not 
Contain

This operator is used to exclude certain employees or schedules that contain the 
value entered in the Field Values field. For example, if the Field Selector is set to 
Activity Code and 12 is entered in the Field Value field, the listing would 
exclude schedules with the value 12 in the code or description.

Does Not 
Equal

This operator is used to exclude employees or schedules which have selected 
values, such as an activity code or job class. The excluded values are selected 
from the menu in the Field Value field.

 5.  In the Field Values field, enter the criteria to determine which schedules are included in the filter.

 l Values can either be typed, or can be selected from the menu by clicking on the Look Up icon 
 to the right of the field.  

 l If more than one value is selected, any of those values will create a match for the filter.
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 l The options displayed in the menu depend on the Field Option selected. For example, if the 
Job Class field option is selected, the options that display on the Field Values menu will be job 
classes for the open organization unit.

Note  

When using the operators Contains, Begins With, and Does Not Contain, the user can type in a 
part of the value to be matched. When using operators such as Equal To or Does Not Equal, the 
match must be exact, and so it is recommended the field values are selected from the menu. See 
the Operator Values above for examples.

 6.  Click on the Add a New Condition icon   to add another criteria option.

 7.  When there is more than one condition, an additional box displays to the left to determine whether 
the schedules must meet all the conditions (Match All) or any one of the conditions (Match Any) to 
be included in the filter results.

 8.  Repeat steps 3 through 5 to add additional criteria options.

 9.  To remove a condition, click on the Clear/Remove Condition icon   to the right of the condition 

line.

 10.  When all conditions have been added, click on the Save icon   at the top of the screen to save this 

filter.  

 11.  A box is displayed to enter a name for the filter. After entering a name, click on the Save button in 
this box.

 12.  Click on the Apply Filter button to load this filter to the schedule screen. Only employees who meet 
the criteria are listed. 

 l If the Highlight matched results box is checked, the schedules that meet the conditions are 
highlighted. All other schedules for qualifying employees are not highlighted.

 l If the Highlight matched results box is not checked, all schedules are displayed the same.

Selecting and Applying a Schedule Filter
An existing filter can be loaded to the schedule screen to limit the employees who are displayed.
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To load and view an existing filter, complete the following steps:

 1.  In the upper right area of the schedule screen, locate the schedule filter section.

 2.  Click on the Load Filter icon  .

A listing of existing filters is displayed.

 3.  Select the filter by clicking on it. The filter is loaded to the screen, and the conditions of the filter can 
be viewed.

 4.  Only employees who meet the criteria are listed in the schedule grid. The number of employees 
included in the filter is displayed at the top of the filter box.

 l If the Highlight matched results box is checked, the schedules that meet the conditions are 
highlighted. All other schedules for qualifying employees are not highlighted.

 l If the Highlight matched results box is not checked, all schedules are displayed the same.

 5.  To remove the filter and display all the employees, click on the Clear Filter button.

Date Headers
The Date Headers are displayed at the top of the schedule grid and also at the top of the Balancing Grid.

 l The date headers display the day of the week and the calendar date.

 l The date headers of weekends are highlighted in a darker shade.

 l The date headers of holidays display the name of the holiday instead of the day of the week. They 
are also highlighted in a different shade. 
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Note  

These holidays are defined in Configuration > Assignments > Holidays.

 l If a schedule note has been attached to a day, an icon is displayed in the date header.

To view the schedule notes, from the tool bar, select the View menu, then the Schedule Notes 
option. All the schedule notes attached to days in the open schedule are displayed.

Scroll Bars
There is often too much information within the schedule window to be able to view it all at once.  Scroll 
Bars are used to adjust the view of information that is displayed, so the user can view certain information 
on the screen. 

Vertical Scroll Bars

Vertical scroll bars are available to the right of the schedule grid and the balancing grid. To adjust the 
view, position the cursor on the scroll bar. Drag the bar up or down to display the desired information in 
the window.

 l The upper scroll bar adjusts the view within the schedule grid window.

 l The lower scroll bar adjusts the view within the balancing grid window.

Horizontal Scroll Bars

The horizontal scroll bar is available between the schedule grid and the balancing grid. To adjust the 
view, position the cursor on the scroll bar. Drag the bar left or right to display the information in the 
window.

In addition to the scroll bar, a scroll map helps you to visualize which dates you are seeing within the 
schedule period and to quickly view another set of days. Select a day or an arrow button to move. The 
time frame you are viewing is shown in a lighter color. 
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To change to a scroll map that shows weeks instead of days, click the Week button on the right. Switch 
between the scroll maps as needed by clicking the Day or Week button. When you are viewing more than 
6 weeks on the screen, the Day/Week button is not available and you only see the scroll map in weeks.

Schedule Grid Functions
The information in the cells within the Schedule Grid can be modified. Schedules can be cut and pasted, 
copied, swapped, added, published, deleted, or have a note attached.

The options that are available for editing the employee schedule grid can be accessed by right-clicking. 
The following menu is displayed.

These options can also be accessed through the tool bar at the top of the screen in the Edit menu.

Adding New Schedules
Adding activity codes and pay codes can be done in several different ways, each with its own advantage. 
See the subsections below this list for details.

 l Type the activity code or pay code. This method is the quickest way to add a schedule, but 
requires you to know the codes and the format required for typing them.

 l Use the Add New Code option. This method is good if you are used to using the tool bar and 
menu options.

 l Double-click a cell. This method is good when you do not know or remember certain details, like a 
code, because you can search for information. This method is also good when you need to alter a 
schedule beyond what you can do by typing it. However, with this method, you can only work in one 
cell at time.
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Type the activity code

 l Add an activity by clicking a cell and typing the activity code. For example, type 0700-8 and press 
Enter.

To change the employee's default profile, type the activity code, a delimiter, and the profile code. For 
example, type 0700-8 CH to change from the default RN profile to a Charge profile.

 o Delimiters are characters that separate strings of text or numbers. Delimiters can be spaces, 
commas, or semicolons.

Examples: 0700-8 CH or 0700-8,CH or 0700-8;CH

 l You can add an activity to a multiple cells at one time. First, select the range of cells and then type 
the activity code.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

Type the pay code

 l Add a pay code by clicking a cell and typing the pay code, start time, and length in hours (all 
separated by delimiters). For example, type PTO 0000 24 (for PTO starting at midnight and lasting 
24 hours) and press Enter.

Leading zeros and colons in the time are not required. For example, these are all acceptable entries: 
0700, 07:00, 700, and 7:00

A decimal point in the hours value is allowed. For example, these are all acceptable entries: 8, 8.0, 
8.5, and 8.50

 o Delimiters are characters that separate strings of text or numbers. Delimiters can be spaces, 
commas, or semicolons.

Examples: PTO 0000 24 or PTO,0000,24 or PTO;0000;24

 l You can add a pay code to a multiple cells at one time. First, select the range of cells and then type 
the pay code details.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 
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Use the Add New Code option

To add a new code to one or more cells, complete the following steps:

 1.  In the schedule grid, highlight the appropriate cell or cells .

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day.

 2.  Use one of following methods to add schedule:

 l Right-click to display the menu and select Add New Code. OR

 l From the tool bar, select the Edit menu, then the Add New Code option.

The outline of an activity box is shown in the cell.

 3.  Type the activity code or pay and press Enter.

 l Activity code: enter the activity code, such as 0700-8

To change the employee's default profile, type the activity code, a delimiter, and the profile 
code. For example, type 0700-8 CH to change from the default RN profile to a Charge profile.

 l Pay code: enter the pay code, start time, and length in hours (all separated by delimiters), such 
as PTO 0000 24 (for PTO starting at midnight and lasting 24 hours)

Leading zeros and colons in the time are not required. For example, these are all acceptable 
entries: 0700, 07:00, 700, and 7:00

A decimal point in the hours value is allowed. For example, these are all acceptable entries: 8, 
8.0, 8.5, and 8.50

Delimiters are characters that separate strings of text or numbers. Delimiters can be spaces, 
commas, or semicolons.

Examples: 0700-8 CH or PTO,0000,24 or PTO;0000;

Double-click a cell

Double-clicking a cell opens a schedule dialog box. This is useful if you want to search for an activity 
code, to assign a different profile than the default, or to enter different start and end times than the original 
activity code.

Some of the information in this screen is already defaulted from the schedule screen, and other 
information is defaulted once the activity code is filled in. The defaulted information can be left or replaced 
with different values. Type in the value or click the search icon   to open a menu of valid options to 

select for the field. 
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To add a new schedule using the schedule dialog box, complete the following steps:

 1.  Double-click in a cell.

The schedule dialog box appears.

 2.  Select the option to indicate whether this is for a Schedule (activity code) or for a Calendar (pay 
code).

 3.  Update any pre-filled information, and enter or search for the details to complete the needed fields.
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 4.  To add a note to this schedule, expand the Notes section.

 5.  A Predefined Note Code can be selected to automatically load subject and body information.

 6.  If a predefined note is not selected, enter a Subject for the title of this note. In the Body field, enter 
the free-form text for information regarding this note.

 7.  Select the Publish this activity when saving option to automatically launch the publishing process 
for this schedule.

If this is not selected, the schedule remains pending.

 8.  When all fields are complete, click on the Save button to save this schedule and close this box.

Handling Validation Errors
After saving a new schedule, if selection style validation errors occur, a Validation Messages dialog 
appears.

Decide whether it is appropriate to continue. If so, click Approve. The schedule is saved.

If there are changes you need to make to eliminate the errors or to select a different employee to work the 
shift, click Cancel. The schedule is not saved.

Moving Employee Schedules Using the Drag-and-Drop Method
Employee schedules can be easily moved from one cell to another using the "drag-and-drop" method. 
Schedules can be moved either to the same employee or to another employee.  

To move a schedule using the drag-and-drop method, complete the following steps:

 1.  In the schedule grid, highlight the cell or cells with the schedules to be moved.

If a cell has more than one schedule and you want to cut only one of them, click the schedule itself to 
highlight it.
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A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Hold the Shift key            and drag the highlighted cell to the cell where the schedule should be moved.

 3.  Release the mouse button and key.

The schedule is moved to the new cell.

Cutting and Pasting Employee Schedules
The Cut and Paste options allow you to remove a schedule from one or more cells and then paste it in 
another cell for the same or different employee. You can continue to paste this same schedule into as 
many cells as needed.

Note  

If you paste into a cell that already has a schedule, the behavior of the original schedule is determined 
by indicator SS Application: SS Solution Standard 5, "Determines the copy and paste method used by 
the Schedule screen".

If the indicator is set to:

 l A - the new schedule is appended, leaving the original schedule in place.

 l O - the new schedule overwrites (deletes) the original schedule.

To cut and paste employee schedules, complete the following steps:

 1.  In the schedule grid, highlight the cell or cells with the schedules to be cut (removed).

If a cell has more than one schedule and you want to cut only one of them, click the schedule itself to 
highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Use one of following methods to cut schedules:

 l Right-click to display the menu and select Cut. OR

 l From the tool bar, select the Edit menu, then the Cut option. OR

 l On the keyboard, press Ctrl-X.

 3.  Highlight the cell where the schedules should be pasted.
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 4.  Use one of following methods to paste schedules:

 l Right-click to display the menu and select Paste. OR

 l From the tool bar, select the Edit menu, then the Paste option. OR

 l On the keyboard, press Ctrl-V.

The schedule you cut is now assigned to the highlighted cells.

Copying and Pasting Employee Schedules
Copying schedules can be done with cut and paste, or by the drag and drop method.

Cut and Paste

The Copy and Paste options allow you to make a duplicate of one or more employee schedules and then 
to paste in another cell for the same or different employee. The copied schedules will have the same 
assignment information as the original, such as activity code or profile. You can paste this same schedule 
into as many cells as needed.

Note  

If you paste into a cell that already has a schedule, the behavior of the original schedule is determined 
by indicator SS Application: SS Solution Standard 5, "Determines the copy and paste method used by 
the Schedule screen".

If the indicator is set to:

 l A - the new schedule is appended, leaving the original schedule in place.

 l O - the new schedule overwrites (deletes) the original schedule.

To copy and paste employee schedules, complete the following steps:

 1.  In the schedule grid, click the cell or cells with the schedules to be copied.

If a cell has more than one schedule and you want to copy only one of them, click the schedule itself 
to highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Use one of following methods to copy schedules:

 l Right-click to display the menu and select Copy. OR

 l From the tool bar, select the Edit menu, then the Copy option. OR

 l On the keyboard, press Ctrl-C.

 3.  Highlight the cell where the schedules should be pasted.
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 4.  Use one of following methods to paste schedules:

 l Right-click to display the menu and select Paste. OR

 l From the tool bar, select the Edit menu, then the Paste option. OR

 l On the keyboard, press Ctrl-V.

The schedule you copied is now assigned to the highlighted cells.

Drag and Drop Method

Employee schedules can be easily copied from one cell to another using the "drag-and-drop" method. 
Schedules can be copied either to the same employee or to other employees. The copied schedule will 
have the same assignment information as the original, such as activity code or profile.

Note  

If you drag into a cell that already has a schedule, the behavior of the original schedule is determined 
by indicator SS Application: SS Solution Standard 5, "Determines the copy and paste method used by 
the Schedule screen".

If the indicator is set to:

 l A, the new schedule is appended, leaving the original schedule in place.

 l O, the new schedule overwrites (deletes) the original schedule.

To drag and drop a schedule, complete the following steps.

 1.  In the schedule grid, highlight the cell or cells with the schedules to be copied.

If a cell has more than one schedule and you want to copy only one of them, click the schedule itself 
to highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Drag the cursor to the cell where the schedules should be copied.

The schedules are copied to the new cell.

Deleting an Employee Schedule
The Delete function is used to remove an employee schedule from the grid. Deleted schedules cannot be 
pasted.

To delete employee schedules, complete the following steps:

 1.  In the schedule grid, highlight the cell or cells with the schedules to be deleted.

If a cell has more than one schedule and you want to delete only one of them, click the schedule 
itself to highlight it.
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A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Use one of following methods to delete schedules:

 l Right-click to display the menu and select Delete. OR

 l From the tool bar, select the Edit menu, then the Delete option. OR

 l On the keyboard, press Delete.

The schedule is deleted.

Editing an Existing Schedule
An existing pending or published schedule can be modified. To edit an existing schedule, complete the 
following steps:

 1.  Double-click the schedule that you want to edit.

Make sure you double-click the schedule. If you double-click in the cell, the resulting dialog box 
assumes you are trying to add a new schedule.

The schedule dialog box appears.

Note  

If any element, such as Profile, Position, Activity Code, Organization Unit, or Job Class, has been 
set to inactive since the schedule was initially created, another window appears explaining what 
has been made Inactive. Before saving, you will need to correct the inactive element by selecting 
an active option.

 2.  Make the necessary updates.

 l If the Activity Code is changed, the Time, Hours/Unit, and Lunch Length (Hours) fields default 
to the values of the related activity code.

 l If the Organization Unit is changed, the Position and Profile fields must be changed to values 
which exist in the updated organization unit. 

 3.  To add or update a note to this schedule, expand the Notes section.

 4.  Select the Publish this activity when saving option to automatically launch the publishing process 
for this schedule.

If this is not selected, the schedule remains pending.

 5.  When all fields are complete, click on the Save button to save this schedule and close this box.
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Note  

If an inactive element has not been corrected, a window appears to alert you. Make the required 
correction before saving.

Publishing Highlighted Schedules
The Publish function is used to publish (post) selected schedules on the Schedule screen.

Note  

To publish all the schedules in the open schedule period, go to Schedule > Publish Schedule

To publish one or more employee schedules, complete the following steps:

 1.  In the schedule grid, highlight the cell or cells with the schedules to be published.

If a cell has more than one schedule and you want to publish only one of them, click the schedule 
itself to highlight it.

A range of cells can be selected by holding Shift as you click or by clicking and dragging. These 
cells can span multiple days in a row and across multiple employees. Alternatively, click an 
employee's name to select all the days for that employee, or click a day in the date header to select 
all the employees for that day. 

 2.  Use one of following methods to publish schedules:

Note that the Publish option is available only when there is at least one pending schedule in the 
selected cells.

 l Right-click to display the menu and select Publish. OR

 l From the tool bar, select the Edit menu, then the Publish option. OR

 l On the keyboard, press Ctrl-U.

The schedules are now published and appear with bolder borders around them.
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Approve or Deny a Schedule Incentive Request

 1.  Open the schedule screen for the appropriate date range and organization unit.

 2.  Find the appropriate date and employee.

A Schedule Incentive request is indicated by an icon. 

 3.  Double-click the request icon.

The Schedule Incentive dialog appears.

 4.  In the Reviewer Comments field, enter comments about your approval or denial of the Schedule 
Incentive request.

Depending on how indicators are set for your organization unit, reviewer comments may be 
required.

 5.  Click Approve or Deny.

If approved, the activity code appears on the schedule screen and if there were other Schedule 
Incentive requests, the other requests are automatically denied.

Deleting, Reopening, and Reassigning a Schedule Incentive Request
If you need to delete a schedule that was bid upon and approved, you can reopen the schedule again for 
bidding or reassign the schedule bid to another employee who had previously bid on the shift.
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 1.  Open the schedule screen for the appropriate date range and organization unit.

Example 

Initially, there may be several Schedule Bid requests for the same shift.

A manager approves one of the Schedule Bid requests and the shift is awarded to that 
employee.

 2.  Delete the schedule.

 3.  Click the save button.

The Schedule Bidding Reopen Wizard appears.

 4.  Select the appropriate action:

To reopen the Schedule Bidding process to other employees, as long as the Closing Date and 
Closing Time have not yet been met, click Reopen.

Any Schedule Bidding requests that were present before the winning schedule was approved will 
remain and reappear on the schedule screen. These employees do not need to bid again on the 
schedule.

To reassign the schedule to another employee who had previously bid on the schedule, select the 
employee from the list under Employee Bids. This allows the Reassign button to become active. 
Click Reassign.
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Zoom Control
The Zoom Control is used to increase or decrease the magnification of the schedule screen. This helps 
the user either focus on details of a schedule or view the entire scheduling period.

Note  

When the schedule is closed, the magnification setting is saved. The next time the user opens the 
screen, the magnification will be the same as the saved setting.

To change the magnification of the screen, complete the following steps:

 1.  Position the cursor over the slider (indicated in the red box below) and hold down the left mouse 
button.

 2.  Move the slider to the right to increase the magnification of the schedule grid.

 3.  Move the slider to the left to decrease the magnification of the schedule grid and show more 
schedule cells.
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Balancing Grid and Activity Balancing Grid
Balancing Grid

The Balancing Grid displays the profiles and organization units for staffing and includes a daily 
breakdown by coverage period of the staffing levels.

Activity Balancing Grid

The Activity Balancing Grid is populated by the Core Staffing by Activity Code feature and displays a daily 
breakdown of needs by activity code and profile.

Note  

Regardless of whether you use the Core Staffing by Activity Code feature, the Activity Balancing Grid 
tab appears on the Schedule screen.

Both Grids

 l Click a column header to re-sort the information by that column. Press <CTRL> and click column 
headers to sort by multiple columns.

 l The Group Headers can be selected to group staffing needs by profile, organization unit, coverage 
period (for the Balancing Grid) or activity (for the Activity Balancing Grid), or no grouping. You can 
collapse or expand each group header. This allows the user to focus on certain groups.

 l The Date Headers (on page 78) display the day of the week and the date for each day in the open 
schedule. If the date is a holiday, the holiday name replaces the day of week.

 l The grid cells show a breakdown by day of the staffing values. The user can select whether to 
display these values as Coverage, Need, Variance or a Fraction of coverage and need.

 l The Staffing Details screen can be viewed by double-clicking on a cell in the balancing grid. The 
view shows the employees who are providing coverage for selected cell.

 l With the My Totals - Creating Custom Totals (on page 97) feature, users can create customized 
subtotals of staffing values at the bottom of the balancing grid. These totals can be for any 
combination of profiles, organization units, and coverage periods (for the Balancing Grid) or 
activities (for the Activity Balancing Grid). 

Activity Balancing Grid - Empty Row Explanation

There is a situation you may notice that requires an explanation. You may see that a row appears in the 
Activity Balancing Grid when there are no scheduled activities that match the Activity Code. This is 
because the process that determines what to show in the grid looks 4 days prior and 2 days after the open 
schedule period that you are viewing. And if that process finds an activity, it allows the row to appear on 
the currently open schedule period. This is to accommodate activities with time lengths that may overlap 
the open schedule period. Therefore, the appearance of the row is simply a way for you to realize that 
there are activities near the open schedule period whose begin or end times may overlap.
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Understand that an activity scheduled outside of the open schedule period that causes the row to appear 
may or may not be counting toward coverage totals, depending on whether the activity is set up to count 
toward coverage totals and whether its length actually overlaps the open schedule period. These 
scenarios are described in the following table.

Scenario

Empty row appears in 
the open schedule 
period?

Counts toward coverage 
totals in the open schedule 
period?

Activity occurs within 4 days prior or 2 
days after the open schedule period

Y Depends on the following 
scenarios

Activity counts toward coverage totals 
and overlaps schedule period

Y Y

Activity counts toward coverage totals 
and does not overlap schedule period

Y N

Activity does not count toward coverage 
totals and overlaps schedule period

N N

Activity does not count toward coverage 
totals and does not overlap schedule 
period

N N

Example: The open schedule period January 1 through January 14. In that time period, there are no 
1500-8 activities scheduled. However, the 1500-8 row does appear in the Activity Balancing Grid (with 
zeroes appearing for the entire period).

The 1500-8 row appears because the process looked back 4 days and found a 1500-8 activity scheduled 
on December 30.

Group Headers (Balancing Grids)
The Group Headers are displayed in the Balancing Grid and Activity Balancing Grid to separate coverage 
information into groups. These groups can be by profile, organization unit, coverage period (for the 
Balancing Grid) or activity (for the Activity Balancing Grid). You may choose not to use any headers 
(none) so all profiles are listed together.

On the Group Header rows, the total needs are shown for each day. The totals are sums of the needs in 
each column in the expanded group.

 l Groups are selected from a menu accessed by right-clicking. Select the Group By (Balancing 
Grids) (on page 106) option to display a listing of options.  

 l The records within each group can be sorted in ascending or descending order. Clicking on the 
header alternately sorts the group in ascending (A-Z, 1-9) order or descending (Z-A, 9-1) order.
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Date Headers
The Date Headers are displayed at the top of the schedule grid and also at the top of the Balancing Grid.

 l The date headers display the day of the week and the calendar date.  

 l The date headers of weekends are highlighted in a darker shade.

 l The date headers of holidays display the name of the holiday instead of the day of the week. They 
are also highlighted in a different shade.

Note  

These holidays are defined in Configuration > Assignments > Holidays.

 

 l If a schedule note has been attached to a day, an icon is displayed in the date header.

To view the schedule notes, from the tool bar, select the View menu, then the Schedule Notes 
option. All the schedule notes attached to days in the open schedule are displayed.

Balancing Grid Cells
The Balancing Grid Cells display the staffing values for the profile/organization unit/coverage period (or 
activity) combination for each day in the scheduling period.

The user can select the type of staffing value to display. The following staffing value options are available:

Staffing 
Value Description

Coverage Displays the number of staff scheduled to provide coverage during the coverage 
period. This value is calculated from the employee scheduled activity codes which 
overlap the coverage period.

Need Displays the number of staff required to provide coverage during the coverage 
period. This value is taken from the Staffing Plan (for the Balancing Grid) and the 
Core Staffing Plan (for the Activity Balancing Grid).
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Staffing 
Value Description

Fraction Displays a fraction of the coverage value over the need value.

Variance Displays the difference between the coverage and the need. A positive variance 
indicates over-staffing, and a negative variance indicates under-staffing.

Balancing Grid Only

The acceptable variance setting allows the user to determine the level at which overstaffed and 
understaffed staffing values are color highlighted in the balancing grid.  

 l When the variance between coverage and need meets or exceeds the acceptable variance values, 
then any understaffed (negative variance) values are highlighted in red and any overstaffed (positive 
variance) values are highlighted in blue.  

 l When the variance between coverage and need is less than the acceptable variance value, the 
values are not highlighted and display in gray.

The acceptable variance values is set up by accessing the right-click menu in the balancing grid, then 
selecting Format > Acceptable Variance (on page 105) > Overstaffing/Understaffing.

When a user sets the focus on a profile/coverage period cell in the balancing grid, the schedules of 
employees providing coverage for that coverage period are highlighted in the schedule grid (in gold).  

This same information can be viewed in another way in the Staffing Details screen. Double-click on a cell 
to open this view.

Staffing Details
The Staffing Details screen is opened by double-clicking on a cell in the balancing grid or by accessing 
the right-click menu. The view shows the employees who are providing coverage for the profile/coverage 
period that is highlighted in the grid. 
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My Totals - Creating Custom Totals
Users can create customized totals for staffing values. These totals can be for any combination of 
profiles, organization units, coverage periods (for the Balancing Grid) or activities (for the Activity 
Balancing Grid). 

These totals display in a separate row in the balancing grid.

Note  

Configure My Totals only appears when there are no filters applied to the schedule.

For more information on setting up custom totals, see the documentation for Configure My Totals (on 
page 107).

Balancing Grid Right-Click Menu
A right-click menu can be displayed for the Balancing Grid and Activity Balancing Grid. With the cursor in 
any of the tabs of the balancing grid, right-click.

The following menu is displayed.

 l Recalculate Staffing Needs (for the Balancing Grid only)

 l Call In Employees
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 l Call Off Employees

 l Add Schedule Notes

 l View Schedule Notes

 l View Staffing Details

 l Set Schedule for Bidding (if you are licensed for the Schedule Incentive module)

 l Open Bidding Schedules

 l Format

Recalculate Staffing Needs

Note  

This option is only available from the Balancing Grid.

The Recalculate Staffing Needs option launches the wizard to recalculate the staffing requirements 
based on patient census and acuity.

For more information, see Recalculate Staffing Needs (on page 50) under the Tasks menu.

Call In Employees
The Call In Employee option launches the Schedule Assistant Call In Wizard to search for and select 
additional staff. This can be used if the schedule is understaffed.

For more information, see Call In (on page 38) under the Tasks menu.

Call Off Employees
The Call Off Employees option launches the Schedule Assistant Call Off Wizard to search for and select 
staff to call off or send home. This feature can be used when the schedule is overstaffed.

For more information, see Call Off (on page 41) under the Tasks menu.

Add Schedule Note
The Add Schedule Note option opens a screen to add a new schedule note to a date and coverage period 
in the open schedule.

For more information, see Adding a Schedule Note (on page 35).

View Schedule Notes
The View Schedule Notes option opens a screen to view the schedule notes attached to dates in the 
open schedule.

For more information, see Schedule Notes (on page 34).
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Set Schedule for Bidding

Note  

Schedule Incentive is a separate module. If your organization does not have Schedule Incentive, this 
option will not be visible.

 1.  Open the schedule screen for the appropriate date range and organization unit.

 2.  In the Balancing Grid, select the shift to be offered through Schedule Incentive.

Note  

You will only be able to select days that are within the Default Days Before Create parameter on 
the Staffing Configuration screen.

Example 

The Default Days Before Create parameter is set to 45 days. You will only be able to set up an 
incentive schedule up to 45 days before the date of the shift. If the shift is 46 days away, you 
cannot yet set up the incentive schedule.

 3.  Right-click on a selected schedule or click the Tasks menu.

 4.  Select Set Schedule for Bidding.

The Incentive Schedule Wizard appears.

Continue creating an incentive schedule by completing the instructions in the following Flat Dollar 
Method (on page 58) or Percentage Method (on page 60) section.

Flat Dollar Method
General Card

Many fields in the Schedule Incentive Wizard have information already filled in. This information came 
from various sources, such as the Staffing Configuration.
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 1.  In the Classification field, select Flat Dollar.

 2.  In the Auto Approve field, select the approval method.

 l To allow the employee with the lowest Schedule Incentive offer to automatically receive the 
schedule when the Close Date and Close Time pass, select Yes. The manager does not have 
to approve the Schedule Incentive request.

 l To require the manager to approve the Schedule Incentive request even after the Close Date 
and Close Time pass, select No.

 3.  In the Activity Code field, enter an activity for the incentive schedule.

 l Type an activity code or click   to select the code from a list.

Only the activity codes configured for Schedule Incentive appear in the list.

 4.  If needed, enter or update the Open Date, Open Time, Close Date, and Close Time.

These values determine when the shift is available to employees to request.

 5.  If needed, edit the Shift Count.

This number is the same as the Need on the Balancing Grid. For example, if the Need is 2, the Shift 
Count is 2.

 6.  The Start Time, Hours/Units, and Lunch Length values default to the values associated with the 
selected activity code.

 7.  Enter a Maximum Bid or Minimum Bid, which represent the highest or lowest dollar amount 
acceptable for this incentive schedule.
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 8.  Enter an Increment value to indicate the minimum dollar increment that employee Schedule 
Incentive requests must meet.

 9.  Click Save.

Organization Open Dates Card

The fields on this card are optional.

 1.  Open the Organization Open Dates card.

The fields allow you to expand the Schedule Incentive offer to other organization units. This allows 
other employees to request shifts that were not requested by employees in the original organization 
unit or shifts with requests that have not yet been approved.

The values indicate the number of days before the shift and the time of day that the shift becomes 
available to employees to start requesting. The fields may already be filled in with dates and times 
from the Staffing Configuration. You may fill in empty dates and times or change the dates and times 
that are already filled in.

 2.  Click Save.

Overrides Card

The fields on this card are optional.
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 1.  Open the Overrides card.

The fields allow you to expand the pool of employees available to request the incentive schedule by 
removing restrictions.

The override options, such as Positions or Stations, show what qualifications an employee needs to 
have to work this shift. However, if you need to expand the pool of employees to fill this shift, you can 
remove some qualifications. You cannot add qualifications.

Example 

You may want to remove a certain license or educational requirement to increase the number of 
employees available.

 2.  Click the appropriate override options and then click the boxes to remove the desired requirements.

 3.  Click Save.

Percentage Method
General Card

Many fields in the Schedule Incentive Wizard have information already filled in. This information came 
from various sources, such as the Staffing Configuration.

 1.  In the Classification field, select Percentage.

 2.  In the Auto Approve field, select the approval method.

 l To allow the employee with the lowest incentive offer to automatically receive the schedule 
when the Close Date and Close Time pass, select Yes. The manager does not have to 
approve the Schedule Incentive request.
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 l To require the manager to approve the Schedule Incentive request even after the Close Date 
and Close Time pass, select No.

 3.  Do not enter an activity code in the Activity Code field.

Note  

Separate activity codes were created, such as SI10, to work with the Percentage method. The 
system automatically determines the correct activity code to attach to this schedule based on the 
other entries made in the Schedule Incentive Wizard.

 4.  If needed, enter or update the Open Date, Open Time, Close Date, and Close Time.

These values determine when the shift is available to employees to request.

 5.  If needed, edit the Shift Count.

This number is the same as the Need on the Balancing Grid. For example, if the Need is 2, the Shift 
Count is 2.

 6.  Enter or edit the Start Time, Hours/Units (the length of the shift), and Lunch Length values.

The Start Time and Lunch Length may default to the values associated with the shift selected for the 
incentive schedule.

 7.  Enter a Maximum Bid or Minimum Bid, which represent the highest or lowest dollar amount 
acceptable for this incentive schedule.

 8.  The Increment field is not used with the Percentage method. Leave blank.

 9.  Click Save.

Organization Open Dates Card

The fields on this card are optional.
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 1.  Open the Organization Open Dates card.

The fields allow you to expand the Schedule Incentive offer to other organization units. This allows 
other employees to request shifts that were not requested by employees in the original organization 
unit or shifts with requests that have not yet been approved.

The values indicate the number of days before the shift and the time of day that the shift becomes 
available to employees to start requesting. The fields may already be filled in with dates and times 
from the Staffing Configuration. You may fill in empty dates and times or change the dates and times 
that are already filled in.

 2.  Click Save.

Overrides Card

The fields on this card are optional.

 1.  Open the Overrides card.

The fields allow you to expand the pool of employees available to request the incentive schedule by 
removing restrictions.

The override options, such as Positions or Stations, show what qualifications an employee needs to 
have to work this shift. However, if you need to expand the pool of employees to fill this shift, you can 
remove some qualifications. You cannot add qualifications.

Example 

You may want to remove a certain license or educational requirement to increase the number of 
employees available.

 2.  Click the appropriate override options and then click the boxes to remove the desired requirements.

 3.  Click Save.

Open Incentive Schedules
In the Balancing Grid, a dollar sign symbol appears on the incentive schedules. 
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To view the incentive schedule details, complete the following steps:

 1.  Right-click on the schedule you want to view.

 2.  Click Open Incentive Schedules.

Format
The Format option displays a menu to customize the way the staffing values display on the Balancing 
Grid and Activity Balancing Grid.

Balancing Grid

You can recalculate the staffing needs, select the number of decimals places to display, indicate which 
staffing values to display, and determine the staffing variance that will be color coded red (when 
understaffed) or blue (when overstaffed)—see Acceptable Variance (below).

Activity Balancing Grid

You can indicate which staffing values to display.

Acceptable Variance

Note  

This option is only available from the Balancing Grid.
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The Acceptable Variance setting allows the user to determine the level at which overstaffed and 
understaffed schedules are color highlighted in the balancing grid. When the variance between coverage 
and need meets or exceeds the variance values set up in this screen, then any understaffed (negative 
variance) values are highlighted in red and any overstaffed (positive variance) values are highlighted in 
blue.

For example, some users may want any variance from the staffing plan to be highlighted. They would set 
both variance values to 0. 

To set the variance for the color highlighting, complete the following steps:

 1.  Position the cursor in the Balancing Grid in any date cell and click. The menu displays.

 2.  Select the Format option, then the Acceptable Variance option, then the Overstaffing option.

A cell is displayed to set the acceptable variance value.

 3.  Enter the variance value in this cell.

Example 

Enter 0 to highlight in blue any overstaffing (positive) variance, or enter another value, such as .2 
to prevent highlighting of small variances.

 4.  Highlight the Understaffing option.

A cell is displayed to set the variance value.

 5.  Enter the variance value in this cell.

 6.  Click on any cell to close the menu and save the changes.

Profile Area Right-Click Menu
A right-click menu can be displayed for the profile/organization unit area.

Group By (Balancing Grids)
The Group By option allows you to select whether the information on the balancing grids should be 
grouped by profile, organization unit, coverage period (for the Balancing Grid) or activity (for the Activity 
Balancing Grid). Select none to display all rows together without grouping.

To access this menu, right-click in the profiles section.
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Select the group option from the menu by right-clicking on one of the following options:

Group Option Description

None Do not group the rows. All rows are displayed together.

Coverage 
Period

from the 
Balancing Grid

Groups rows by the coverage period that overlaps the time frame of the 
employee schedules.

Activity

from the Activity 
Balancing Grid

Groups rows by the activity codes required during the schedule period.

Profile Groups rows by the profile code assigned to the employee schedules. Profiles 
include the job class and organization unit of the assignment.

Organization 
Unit

Groups rows by the organization unit assigned to the employee schedules. 

Configure My Totals
You can create customized totals of coverage at the bottom of the Balancing Grid and Activity Balancing 
Grid. These totals can be for any combination of profiles, organization units, coverage periods (for the 
Balancing Grid) or activities (for the Activity Balancing Grid). 

Note  

Configure My Totals only appears when there are no filters applied to the schedule.

To create customized totals, complete the following steps:

 1.  In the left pane of the Balancing Grid or Activity Balancing Grid, right-click and select Configure My 
Totals.
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The following set up screen appears.

Sample screen from the Balancing Grid

 2.  In the header row, right-click and select Add New Totals.

A new column is added to the screen.

 3.  Type a new name for your custom totals row.

 4.  Select the by profile, organization unit, coverage period (for the Balancing Grid) or activity (for the 
Activity Balancing Grid) combinations to include in the new totals by clicking the boxes under your 
new column.

 5.  When all options are selected, click Save.

 6.  The new My Totals row is included in the grid.

Sample screen from the Balancing Grid
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 7.  Change the name or remove the My Totals row at any time. To do so:

 a.  Right-click and select Configure My Totals.

 b.  Right-click on the name of your custom My Totals row.

 c.  Select Rename or Remove.
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Requests
The Requests tab opens a screen which displays the pending employee requests. Authorized users can 
handle (approve, deny, cancel) requests from this screen.

Selecting the Request Type

Select the type of request from the Select Request Type drop down menu. The fields that display on the 
requests screen are determined by the request type selected.

Filtering the Requests List

A filter can be applied to limit the number of requests that are displayed on the screen.

In the Enter Filter Term field on the right side of the screen, enter filter criteria. This can be alphanumeric 
text, such as employee name information or status or date information.

The filter is automatically applied.

Actions

The following actions are available for handling employee requests:

Approve

Select Approve to approve an employee's request.

To approve one or more records, complete the following steps:

 1.  Select each request you want to approve.

 2.  Click Approve.

Tip  

For transaction requests, a Time Off informational message appears by default if other 
employees in the department or unit have overlapping time off.

Click the link in the message to show a list of the employees.

The status of the request is updated to Approved. In the schedule grid, the request is removed from 
the Requests tab and the request icon in the schedule grid updates to the appropriate calendar 
symbol.

Deny

Select Deny to inform employees that their requests are not allowed.  

To deny one or more records, complete the following steps:

 1.  Select each request you want to deny.

 2.  Click Deny.

The status of the request is updated to Denied. In screens that display an icon, the denied request is 
represented with  .
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Delete

Select Delete to remove one or more requests.  

To delete one or more records, complete the following steps:

 1.  Select each transaction request you want to delete.

 2.  Click Delete.

 3.  In response to the verification message that appears, click Yes.

Set Pending

Select Set Pending Review to inform employees that their requests have been seen, but have not yet 
been handled.

To set the status of a record to Pending Review, complete the following steps:

 1.  Select each request you want to set to a Pending Review status.

 2.  Click Set Pending Review.

 3.  In response to the verification message that appears, click Yes.

The status of the request is updated to Pending Review.

Transaction
The Transaction option displays all the employees who have a calendar request submitted for the open 
scheduling period.

Employees submit calendar requests from the Employee record > Actions > Add Calendar.
In the schedule grid, an icon    displays on the days an employee has a pending calendar request. 

When you select records in the Request tab, the corresponding transactions in the schedule grid are 
highlighted with a bold border  .

Handling/Viewing a Single Request

To view the details of a specific transaction request, double-click the transaction request icon or the row 
on the Requests tab. The following screen appears.
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To handle a single request, complete the following steps:

 1.  Optional. Open the Benefits Balances card to view the employee's benefit balances (for the current 
pay period) before making the decision to approve.

 2.  In the Reviewer Comments field, enter any notes regarding this request, such as the reason this 
trade or offer is approved or denied.

 3.  Click an action to update the status of the request.

Handling Multiple Requests 

You can handle multiple requests from the Requests tab; however, you must be assigning the same 
status to all the selected records. For example, you can select multiple records and then approve them.

To handle multiple requests, complete the following steps:

 1.  Select the records that you want to update to the new status.

 2.  Click an action to assign the corresponding status to all of the selected records.
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Unavailability
The Unavailability options lists all the employees who have an unavailability request or a recurring 
unavailability request submitted for the open scheduling period. Unavailability indicates that the 
employee is not available to work during certain time frames.

Employees submit unavailability requests through their Employee record > Actions.

Authorized users can handle requests from this screen. See the steps below for Handling/Viewing a 
Single Request and/or Handling Multiple Requests.

In the schedule grid, a bar   displays on the days an employee has a pending unavailability 
request. A pending recurring unavailability request displays the following bar  . When a record is 
checked in the Requests grid, the bars for the related days are highlighted with a dark border  .

Handling/Viewing a Single Request 

Authorized users can handle a single request from this screen.

 1.  Double-click on the line of a specific request to open it and to view more details.

 2.  In the Reviewer Comments field, enter any notes regarding this request, for example, the reason 
this request was approved, denied or set to set pending.

 3.  Click on the action button for this request.

 4.  If the request is approved, the green bars display without the star for recurring unavailability 
 and unavailability 

 5.  If the request is denied, the bars are removed from the schedule grid.

Handling Multiple Requests

Authorized users can handle multiple requests from this screen by completing the following steps:

 1.  Check the box to the left of each request which is to be given the same status, such as approved, 
denied, deleted, or set to pending. Clicking on the box alternately adds and removes the check 
mark.

 2.  Click on the action button for this request (see descriptions below).

Trade
The Trade option displays all the employees who have a request to trade schedules or an offered 
schedule submitted for the open scheduling period.

Employees submit trade and/or offer requests from Employee > Actions> Self Scheduling.
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A trade request needs to be approved by the second employee involved in the trade. This second 
employee is the "accepting employee". The schedules are not traded on the Schedule grid until the 
request is approved by a supervisor.

In the schedule grid, an icon   displays on the days an employee has a pending trade or offer 

request. When the box is checked in the Requests grid, the shifts involved in the transaction are 
indicated with a bold border  .

Handling/Viewing a Single Request

To view the details of a specific trade or offer request, double-click on the line of the record. The following 
screen is displayed to do a side-by-side comparison of the shifts.

 l Under the Requesting column, the information on the employee who initiated the trade or offer is 
displayed.

 l Under the Accepting column, the information on the second employee involved in the trade or the 
employee who accepted an offered shift is displayed.

To handle a single request, complete the following steps:

 1.  In the Reviewer Comments field, enter any notes regarding this request, for example, the reason 
this trade or offer was approved or denied.
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 2.  Click on the action button for this request.

The shifts are traded on the schedule when the request is approved.

Handling Multiple Requests 

Multiple requests can be handled together, if the user is assigning the same status to all the selected 
records. For example, a user can select multiple records and then approve them.

Authorized users can handle multiple requests from this screen by completing the following steps:

 1.  Select the records to be awarded the same status by checking the box to the left of the record. 
Clicking on the box alternately adds and removes the check mark.

 2.  Click on the action to assign to all selected records.

The shifts are traded on the schedule when the request is approved.

Schedule Incentive
The Schedule Incentive option displays the schedules which have been set up for bidding during the 
open scheduling period. Double-click on a record to open it and view the employees who have submitted 
a bid for that date.

Employees submit Schedule Incentive requests through Action > Employee > Employee Schedule 
Incentive. For more information, see Set Schedule for Bidding (on page 57). 

Authorized users can view the details of the Schedule Incentive requests, including the employees who 
have submitted bids and the amounts of the bids. The can also handle requests from this screen, 
approving or denying bids. 

In the schedule grid, an icon   displays on the days that employees have a Schedule Incentive 

request. When a Schedule Incentive record is checked in the Requests grid, the icons of all employees 
submitting bids for that record are highlighted with a dark border in the schedule grid  .
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Viewing the schedule incentive records

To view the details of a specific Schedule Incentive record, double-click on the line of the record. The 
following screen is displayed.

 l The employees who have submitted a bid for the schedule are displayed, along with their lowest bid.

 l Authorized users can enter a comment in the Reviewer Comments field.
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Handling a Schedule Incentive Bid

To change the status of a bid, complete the following steps:

 1.  Click on the line containing the employee name.

 2.  Enter a comment in the Reviewer Comments field, if desired. This comment will be attached to the 
employee's Schedule Incentive record.

 3.  Select the appropriate button.

 l If the Approve button is selected:

 o The schedule is awarded to the employee and the activity is displayed on the schedule grid.  

 o The schedule incentive request icons are removed from the schedule grid for all other bidders.

 o The pay rate that was awarded for the schedule incentive is displayed in in the Rate field.

If the Deny button is selected:

 o The schedule incentive bid is set to Denied.

 o Any comment entered in the Reviewer Comments field is added to the record.
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 o The Schedule Incentive request icon is removed from the schedule grid for that employee.

Work
The Work option displays all the employees who have submitted a request to work for the open 
scheduling period.

Employees submit requests to work from their Employee > Actions > Request to Work. Employees 
search for unfilled schedule openings and select the ones they want to work.

In the schedule grid, an icon   displays on the days the employee has a pending request to work. 

When the record is checked in the Requests grid, the icon for that request shows a bold border  .

Handling/Viewing a Single Request

To view the details of a specific request to work record, double-click on the line of the record. The 
following screen appears.
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To handle a single request, complete the following steps:

 1.  In the Reviewer Comments field, enter any notes regarding this request, for example, the reason 
this request was approved or denied.

 2.  Click on the action button for this request.

 l When the action is set to Approve, the system validates the scheduling rules, based on the Request 
to Work Selection Style. The employee is assigned the activity code displayed in the request to work 
record.

 l When the action is set to Deny, the employee is not assigned the schedule. The icon is removed 
from the grid. 

Handling Multiple Requests 

Multiple requests can be handled together, if the user is assigning the same status to all the selected 
records. For example, a user can select multiple records and then approve them.

To handle multiple records, complete the following steps:

Authorized users can handle multiple requests from this screen by completing the following steps:

 1.  Select the records to be awarded the same status by checking the box to the left of the record. 
Clicking on the box alternately adds and removes the check mark.

 2.  Click on the action to assign to all selected records (see option listings below).  

Note  

Employees can view the change in status of their requests on their Home Page on the My Requests to 
Work card and on the Requests card in the employee TCS screen. When the action is set to Deny, the 
icon is removed from the screen and the employee is not assigned the activity code.
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Class Enrollment
The Class Enrollment option displays all the employees who have requested enrollment in an education 
tracking class during the open scheduling period.

Employees submit a request for enrollment from their Employee > Actions >  Class Schedule.
Within the employee schedule, an icon   displays on the days the employee has a pending education 

class request. When the request is checked in the Request grid, the icon is highlighted in the schedule 
grid  .

Handling/Viewing a Single Request

To view the details of a specific education request record, double-click on the line of the record.

To handle a single request, complete the following steps:

 1.  In the Reviewer Comments field, enter any notes regarding this request, for example, the reason 
this request was approved or denied.

 2.  Click on the action button for this request.

 l If the Approve button is selected, the employee is added to the class roster. The icon   is 

displayed in the schedule grid on the day of the class.

 l If the Deny button is selected, the employee is not added to the class roster. The icon is 
removed from the schedule grid.

Handling Multiple Requests 

Multiple requests can be handled together, if the user is assigning the same status to all the selected 
records. For example, a user can select multiple records and then approve them.

To handle multiple records, complete the following steps:

 1.  Select the records to be awarded the same status by checking the box to the left of the record. 
Clicking on the box alternately adds and removes the check mark.

 2.  Click on the action to assign to all selected records.
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Employee Schedule Exceptions
On the schedule screen, violations appear as a   icon in the Exceptions column. If you do not see the 

Exceptions column, you can add it. For information, see Show/Hide Details (on page 67).

From the Employee Schedule Exceptions tab

 l Click the Employee Schedule Exceptions tab.

 o The total number of exceptions appears in parentheses.

 o A list appears with the details of the exceptions, such as employee information and the type of 
violation, such as violating the weekly overtime hours.

From the Employee Information area

 l Click   in the appropriate employee's row.

 o The employee's violations appear on the Employee Schedule Exceptions tab.

 o The employee's name appears in the filter field on the tab. View all employee exceptions by 
clicking X in the filter field.
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